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Survey - gain an overview 

System structure of AC500/S500-FBP 

The principle system structure is shown in the following figure: 
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Explanation 

The following electronic modules are the basic components of the AC500 system: 

• CPUs of three different performance classes 
• Couplers for various bus systems: Fieldbus systems PROFIBUS DP, CANopen, DeviceNet; Ethernet 

couplers. 

Central expansion: One CPU supports direct connection of up to seven S500 FBP system I/O devices. 

Decentralized expansion: Using the DC505 FBP interface module (for fieldbus systems PROFIBUS DP, 
CANopen, DeviceNet, Modbus RTU), up to seven S500 FBP system I/O devices can be connected (with 
a maximum of four analog modules). 

Mechanical mounting of the electronic modules is done using CPU terminal bases (for the CPU and the 
couplers) and I/O terminal units (for the I/O modules), designed for snap-on mounting on a DIN rail or for 
screw-mounting on a mounting panel. 
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AC500 system overview 

AC500 is a complex state-of-the-art system providing extensive automation potential for your plant. 

 

Figure: AC500 system 

The following pages provide a summary of all devices available for the AC500 system. For detailed 
information about the individual devices please refer to the respective hardware description.
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Overview of available CPUs 

Type Order number Description 

PM571 1SAP 130 100 R0100 PM571, CPU 64kB, 24 V DC, Memory Card Slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display 

PM571-ETH 1SAP 130 100 R0170 PM571-ETH, CPU 64kB, 24 V DC, Memory Card Slot, 2x 
RS-232/485 (Programming, MODBUS/CS31), 1x FBP, 
Display, integrated Ethernet TCP/IP 

PM581 1SAP 140 100 R0100 PM581, CPU 256kB, 24 V DC, Memory Card Slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display 

PM581-
ARCNET 

1SAP 140 100 R0160 PM581-ARCNET, CPU, memory 256 kB, 24 V DC, 
Memory Card Slot, interfaces 2 x RS-232/485 
(programming, Modbus/CS31), 1 x FBP, Display, 
integrated coupler ARCNET 

PM581-ETH 1SAP 140 100 R0170 PM581-ETH, CPU 256kB, 24 V DC, Memory Card Slot, 2x 
RS-232/485 (Programming, MODBUS/CS31), 1x FBP, 
Display, with integrated Ethernet TCP/IP coupler 

PM582 1SAP 140 200 R0100 PM582, CPU, memory 512 kB, 24 V DC, Memory Card 
Slot, interfaces 2 x RS-232/485 (programming, 
Modbus/CS31), 1 x FBP, Display 

PM582-ETH 1SAP 140 200 R0170 PM582-ETH, CPU, memory 512 kB, 24 V DC, Memory 
Card Slot, interfaces 2 x RS-232/485 
(programming, Modbus/CS31), 1 x FBP, Display, 
integrated coupler Ethernet TCP/IP 

PM591 1SAP 150 100 R0100 PM591, CPU 4MB, 24 V DC, Memory Card slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display 

PM591-
ARCNET 

1SAP 150 100 R0160 PM591-ARCNET, CPU, memory 4 MB, 24 V DC, Memory 
Card Slot, interfaces 2 x RS-232/485 (programming, 
Modbus/CS31), 1 x FBP, Display, integrated coupler 
ARCNET 

PM591-ETH 1SAP 150 100 R0170 PM591-ETH, CPU 4MB, 24 V DC, Memory Card Slot, 2x 
RS-232/485 (Programming, MODBUS/CS31), 1x FBP, 
Display, with integrated Ethernet TCP/IP Coupler 

Overview of available couplers 

Type Order number Description 

CM572-DP 1SAP 170 200 R0001 CM572-DP, Communication Module PROFIBUS DP 
Master 12 Mb/s 

CM575-DN 1SAP 170 500 R0001 CM575-DN, Communication Module DeviceNet Master 

CM577-ETH 1SAP 170 700 R0001 CM577-ETH, Communication Module, Ethernet TCP/IP, 
with integrated 2-port switch 

CM578-CN 
  

1SAP 170 800 R0001 CM578-CN, Communication Module, CANopen Master 
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Overview of available CPU terminal bases 

Type Order number Description 

TB511-
ARCNET 

1SAP 111 100 R0160 TB511-ARCNET, CPU Terminal Base AC500, 1x CPU 
Slot, 1x Coupler Slot, ARCNET COAX Connector 

TB511-ETH 1SAP 111 100 R0170 TB511-ETH, CPU Terminal Base AC500, 1x CPU Slot, 1x 
Coupler Slot, Ethernet RJ45 Connector 

TB521-
ARCNET 

1SAP 112 100 R0160 TB521-ARCNET, Terminal Base AC500, 1x CPU Slot, 2x 
Coupler Slots, ARCNET COAX Connector 

TB521-ETH 1SAP 112 100 R0170 TB521-ETH, CPU Terminal Base AC500, 1x CPU Slot, 2x 
Coupler Slots, Ethernet RJ45 Connector 

TB541-ETH 1SAP 114 100 R0170 TB541-ETH, CPU Terminal Base AC500, 1x CPU Slot, 4x 
Coupler Slots, Ethernet RJ45 Connector 

  

Overview of available I/O modules 

Type Order Number Description 

DI524 1SAP 240 000 R0001 DI524, Digital Input Module, 32 DI, 24 V DC, 1-wire 

DC522 1SAP 240 600 R0001 DC522, Digital input/output module, 16 DC, 24 V DC / 0.5 
A, 2-wire 

DC523 1SAP 240 500 R0001 DC523, Digital input/output module, 24 DC, 24 V DC / 0.5 
A, 1-wire 

DC532 1SAP 240 100 R0001 DC532, Digital Input/Output Module, 16 DI / 16 DC, 24 V 
DC / 0.5 A, 1-wire 

DX522 1SAP 245 200 R0001 DX522, Digital Input/Output Module, 8 DI 24 V DC, 8 DO 
Relay,  2-wire 

DX531 1SAP 245 000 R0001 DX531, Digital Input/Output Module, 8 DI, 230 V AC, 4 DO 
Relay, 2-wire 

AI523 1SAP 250 300 R0001 AI523, Analog input module, 16 AI, U/I/Pt100, 12 Bit + sign, 
2-wires 

AO523 1SAP 250 200 R0001 AO523, Analog output module, 16 AO, U/I, 12 Bit + sign, 2-
wires 

AX521 1SAP 250 100 R0001 AX521, Analog input/output module, 4 AI / 4 AO, U/I/Pt100, 
12 Bit + sign, 2-wires 

AX522 
  

1SAP 250 000 R0001 AX522, Analog Input/Output Module, 8 AI / 8 AO, 
U/I/Pt100, 12 Bit + sign, 2-wire 

  

Overview of available terminal units 

 Type Order Number Description 

TU515 1SAP 212 200 R0001 TU515,  I/O Terminal Unit, 24 V DC, Screw Terminals 

TU516 1SAP 212 000 R0001 TU516, I/O Terminal Unit, 24 V DC, Spring Terminals 

TU531 1SAP 217 200 R0001 TU531,  I/O Terminal Unit, 230 V AC, Relay, Screw 
Terminals 

TU532 1SAP 217 000 R0001 TU532,  I/O Terminal Unit, 230 V AC, Relay, Spring 
Terminals 

TU551-CS31 1SAP 210 600 R0001 TU551-CS31, Bus-I/O Terminal Unit, 24 V DC, Screw 
Terminals 

TU552-CS31 1SAP 210 400 R0001 TU552-CS31, Bus-I/O Terminal Unit, 24 V DC, Spring 
Terminals 
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Overview of available FBP interface modules 

Type Order Number Description 

DC505-FBP 1SAP 220 000 R0001 DC505-FBP, FBP-Interface Module, 8 DI / 8 DC, 24 V DC / 
0,5 A, 1-wire 

DC551-CS31 1SAP 220 500 R0001 
  

DC551-CS31, Digital Input/Output-Bus Module, 8DI / 16DC 
24 V DC / 0,5 A, 1-wire 

Overview of available FBP terminal units 

Type Order Number Description 

TU505 1SAP 210 200 R0001 TU505, FBP Terminal Unit, Screw Terminals 

TU506 1SAP 210 000 R0001 TU506, FBP Terminal Unit, Spring Terminals 

 Overview of available FieldBusPlugs and accessories 

Type Order number Description 

PDP22-FBP.025 1SAJ 2401 00 R1003 PDP22-FBP.025 PROFIBUS DP-V0/V1-FBP 0.25 m, 
modular (FieldBusPlug) 

PDP22-FBP.050 1SAJ 2401 00 R1005 PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m, 
modular (FieldBusPlug) 

PDP22-FBP.100 1SAJ 2401 00 R1010 PDP22-FBP.100 PROFIBUS DP-V0/V1-FBP 1 m, 
modular (FieldBusPlug) 

PDP22-FBP.200 1SAJ 2401 00 R1020 PDP22-FBP.200 PROFIBUS DP-V0/V1-FBP 2 m, 
modular (FieldBusPlug) 

PDP22-FBP.500 1SAJ 2401 00 R1050 PDP22-FBP.500 PROFIBUS DP-V0/V1-FBP 5 m, 
modular (FieldBusPlug) 

PDV11-FBP.0 1SAJ 924 008 R0001 Feeding connector 24 V DC, Code B-A 

PDV12-FBP.0 1SAJ 924 011 R0001 Feeding connector 24 V DC, Code A-A 

PDA11-FBP.050 1SAJ 924 009 R0005 Adapter M12-Dsub9-M12, cable length 0.50 m 

PDA12-FBP.050 1SAJ 924 010 R0005 Adapter M12-Dsub9-M12, cable length 2 x 0.50 m 

PDR11-FBP.150 1SAJ 924 007 R0001 Terminating resistor 150 Ohm 

  

Overview of available accessories 

Type Order Number Description 

TA521 1SAP 180 300 R0001 TA521, Lithium Battery 

MC502 1SAP 180 100 R0001 MC502, SD Memory Card 128 MB 

TK501 1SAP 180 200 R0001 TK501, Programming Cable, D-Sub / D-Sub 

TK502 1SAP 180 200 R0101 TK502, Programming Cable, Terminal Block / D-Sub 

TA523 1SAP 180 500 R0001 TA523, Pluggable Marker Holder (10 pcs) 

TA524 1SAP 180 600 R0001 TA524, Dummy Coupler Module 

TA525 1SAP 180 700 R0001 TA525, Set of 10 white Plastic Markers 

TA526 1SAP 180 700 R2001 TA526, Wall mounting accessory, 10 pcs 

PS501-PROG 1SAP 190 100 R0001 PS501-PROG, Control Builder AC500, Programming 
Software German / English / French (CD-ROM incl. 
Online Help and PDF Docs) 
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Bus systems overview 

Bus System Short information /  Web Links / Block Libraries 

ARCNET www.arcnet.com ARCNET Trade Association, USA; -> Literature -> Other Puplications 
-> ARCNET Tutorial and Product Guide 

CANopen www.can-cia.org 

DeviceNet www.odva.org -> DEVICENET 

Ethernet www.ethermanage.com 
The Ethernet Library -> see ‘Function Block Libraries AC500’ 

Modbus www.modbus.org 

PROFIBUS www.profibus.com -> Web Based Training 
The PROFIBUS DP Library -> see ‘Function Block Libraries AC500’ 
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Brief information about ARCNET 

ARCNET (Attached Resource Computer NETwork) 
ARCNET is an open, multi-purpose field bus solution with real-time capability. It can be used for multi-
master networking and for programming the AC500 and AC31 controller series, but also for connecting 
additional ARCNET subscribers, e.g. PCs via an appropriate interface card (see catalog). 

Topology  

ARCNET is one of the few networks that can be operated in every conceivable topology. Options include 
bus, star, or tree topologies, or mixtures of these. This means that ARCNET can be used for a broad 
field of different applications. 

Bus assignments  

ARCNET operates on the token-passing procedure, where each subscriber has equal rights. 

Configuration mechanisms  

ARCNET subscribers can freely join and leave during an active runtime session. The system will 
automatically configure the available user database. 

Security mechanisms  

A 16-bit CRC is appended to every data packet, and checked by the recipient. If the token is lost, a 
reconfiguration routine will be initiated, and the network will automatically be restructured. Additionally, 
diagnostic registers are available. 

Physical characteristics  

ABB recommends coaxial cables as transmission medium, for direct connection to the CPU. But also 
twisted-pair cables or (glass, plastic) fiber-optic cables can be connected via bus converters. The line 
lengths that can be achieved without any intermediate amplifiers depend not only on the used medium, 
but also on the selected baud rate and the number of subscribers. The ranges per segment vary from 
approximately 120 m for a simple two-wire bus, up to 3 km for fiber-optics, in each case at 2.5 MBit/s. By 
providing appropriate hubs, different topologies and transmission media can be combined with each 
other and the transmission distance can be increased. The coaxial cables used are a type with 93 Ohm, 
e.g. RG 62. The permissible twisted-pair cables are specified in IEEE 802.3i-1990. At 2.5 MBit/s and with 
coaxial cables, for example, the maximum length of a bus segment is 300 m with eight subscribers and 
without a hub. With twisted-pair cables, under the same conditions, a maximum length of approximately 
120 m can be achieved. The maximum transmis-sion length depends on the number of connected 
subscribers. With coaxial cables, a maximum of 16 km can be achieved; with twisted-pair cables 
approximately 6 km, in each case at 2.5 MBit/s. The fiber-optic link provides the highest degree of 
interference immunity. With glass fiber-optics, distances of up to 3 km are possible at 2.5 MBit/s; with 
plastic fiber-optic cables only small distances of up to approximately 100 m. The baud rate plays no 
significant role in fiber-optic cable transmission. Here, the range can as well be extended using hubs. 

Diagnostics 

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called 
using the programming tool. 

ARCNET – the functionality at a glance  

• Guaranteed collision-free data transmission, guaranteed response times and real-time capability thanks 
to token-passing 

• Large network dimensions: network length 300 m, with amplifier max. 16 km 
• Secure, thanks to checksums in the data packet and handshake protocol between transmitter and 
  receiver 
• Variable network structure: bus, tree and star topologies are possible, plus any desired mixtures of them 
• Variable networking media, coaxial cables, twisted-pair cables and fiber-optic cables can be mixed 
• Automatic subscriber log-on and log-off; the network automatically incorporates new stations in the ring 
  and cancels them as well 
• Master-master access: the subscriber that holds the token is the master. With up to 255 masters at the 
  same network 
• Data transmission rate of max. 2.5 MBit/s 
• ARCNET is configured and programmed using the AC500 Control Builder engineering tool 
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Brief information about CANopen and DeviceNet 

CANopen (Controller Area Network) and DeviceNet  

The CANopen protocol was originally developed for the European automotive industry to replace 
expensive cabling with an affordable system. Today, it is also used in the field of automation for 
transmitting process data between control systems, decentralized I/O modules, drives, valves, etc. CAN 
features a high level of transmission security, since large portions of the monitoring mechanisms have 
been implemented directly in the CAN chip. DeviceNet and CANopen utilize the physical structure and 
the data transport mechanisms of CAN (Controller Area Network). The difference lies in the transmission 
protocols. DeviceNet and CANopen can be used correspondingly for the AC500 and AC31 controller 
series and for field-bus-neutral FBP devices (decentralized I/Os and intelligent switching devices), via 
the CANopen-FBP plug connector. 

Data transmission  

Two types of message have been defined: I/O data transfer and direct link. I/O data transfer is used for 
time-critical process data, while the direct link can be, for example, used for diagnostic messages. 

Bus access for subscribers  

The connection ID with the lower address has higher priority on the bus. Data is transmitted by the 
source, while the sinks (i.e. receivers of the data) have likewise been specified during the configuration 
phase. 

CANopen 

The bus operates on the master/slave principle with one master and up to 127 slaves. A shielded 
twisted-pair cable is used, according to ISO 11898. Cable lengths and transmission rates: from max. 40 
m at 1 MBit/s to 1000 m at 20 kBit/s. 

DeviceNet 

The bus operates on the multi-master and/or the master/slave principle, with up to 64 bus subscribers. 
Two types of shielded twisted-pair cables are used: trunk cable for the main line and drop cable for the 
branch line. 

Transmission rate 125 Kbit/s 250 Kbit/s 500 Kbit/s 

Max. cable length of 
trunk line 
Trunk cable 

500 m (1610 ft) 250 m (820 ft) 100 m (328 ft) 

Max. cable length of 
trunk line Drop cable 

100 m (328 ft) 100 m (328 ft) 100 m (328 ft) 

Max. cable length per 
branch line 
Trunk cable/Drop 
cable 

6 m (20 ft) 6 m (20 ft) 6 m (20 ft) 

Max. cable length total 
branch line 
Trunk cable/Drop 
cable 

156 m (512 ft) 78 m (256 ft) 39 m (128 ft) 

Diagnostics  

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called 
using the programming tool. In addition, the device status is indicated at the communication module by 
four LEDs.  
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Brief information about CS31 field bus 

CS31 (Communication Serial Field Bus, developed by ABB in 1989) for continuity and 
migration   

CS31 is a proprietary master/slave field bus. It is characterized by simple handling, easy configuration, 
and inexpensive installation. The COM1 interface of the AC500 can be configured as a CS31 field bus 
master. 

Communication  

Is handled using polling, i.e. the master sends a request to the slave and then receives the response. 
The CS31 operating mode of COM1 is set using the engineering tool. 

Topology  

Multi-point line, RS485, approved without branch lines. A system consists of one master and up to 31 
slaves. The maximum cable length is 500 m, or 2 km with an amplifier. Slaves are primarily 
decentralized input/output modules with integrated CS31 bus connection. 

Data transmission  

Is performed at 187.5 kB/s. Each telegram has an 8-bit CRC appended. The telegrams enable process 
data (input/output data) to be written and read. 

Transmission medium  

Primarily a twisted-pair, shielded cable with terminators. Other transmission media: fiber-optic cables via 
a converter (glass fibers max. 3 km, plastic max. 100 m), contact lines, slip rings (bus length max. 50 m) 
and data photocells. 

Diagnostics  

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called 
using the programming tool. 
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Brief information about Ethernet 

Ethernet 

Ethernet operates with a data rate of 10 MBit/s and as Fast-Ethernet with 100 MBit/s. Ethernet utilizes 
the producer/consumer model. This means that every station possesses equal rights. While it is 
transmitting, all other stations listen in and accept the data directed to them. Bus access is regulated by 
the CSMA/CD procedure (Carrier-Sense Multiple-Access with Collision Detection), where each station 
may autonomously transmit when the bus is free. If a collision occurs, if two stations begin to transmit 
simultaneously, both of them will stop transmission and wait for a randomly determined time before they 
transmit again. Ethernet defines the Layers 1 (Physical Link) and 2 (Data Link) of the OSI model. 

The AC500 supports transmission and reception of data using TCP/IP and/or UDP/IP. Further 
application layers can be implemented by subsequent loading. Simultaneous operation of TCP/IP, 
UDP/IP and application layer is also assured. The IP, TCP, UDP, ARP, RP, BOOTP, and DHCP 
protocols are supported as a standard feature, as application layer Modbus/TCP. 

Topology 

Star- or ring-shaped using Ethernet hub or switch. 

Data transmission  

Max. 10 MB/s with 10 Base T and max. 100 MB/s with Fast-Ethernet. 

Transmission media  

Twisted-pair cables with RJ45 connector. The maximum cable length is 100 m for 100 MB/s. 

Diagnostics 

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called 
using the programming tool. In addition, the device status is indicated at the communication module by 
four LEDs. 
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Brief information about Modbus 

Modbus® RTU (developed by Modicon in 1979)  

Modbus® RTU is an open master/slave protocol, and can be easily implemented on serial interfaces. 
Numerous automation systems have Modbus® RTU interfaces as standard or optional features, and are 
thus easily able to communicate with the AC500 via its integrated COM1 and COM2 interfaces (RS232 
or RS485). The Modbus® is used not only in industrial applications, but also in building installations, in 
energy optimization systems, for long-distance data transmission and for linking up operator panels. 

Communication  

By polling, i.e. the master transmits a request to the slave and then receives the response. Both 
interfaces COM1 and COM2 can operate simultaneously as Modbus interfaces. The Modbus operating 
mode of an interface is set using the engineering tool. 

Topology  

Point-to-point via RS232 or multi-point via RS485. With RS232, a maximum of one master and one slave 
is possible, while with RS485 one master and a maximum of 31 slaves can be operated. The maximum 
cable length is 15 m with RS232 and 1.2 km with RS485. 

Data transfer  

Max. 187.5 kB/s. Each telegram has a 16-bit CRC appended. The telegrams permit process data 
(input/output data) to be written and read, either individually or in groups. The data are packed in the 
RTU format.   

Transmission media    

May vary. One widely used option is the RS485 bus physics, a twisted-pair, shielded cable with 
terminators. 

Diagnostics 

Detailed diagnostic messages for rapid trouble-shoot-ing are shown on the CPU display or can be called 
using the programming tool. 
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Brief information about PROFIBUS DP 

PROFIBUS DP (Process Field Bus - Decentral Periphery)   

PROFIBUS DP is an open, high-speed and widely-used field bus. It provides multi-master and master-
slave communication in the field area. This field bus can accordingly be used for AC500 and AC31 
control system series and for field-bus-neutral FBP devices (decentralized I/Os and intelligent switching 
devices) via the PROFIBUS-FBP connector. 

Communication 

The masters rule data traffic on the bus. When in possession of the bus access authorization (token), the 
masters can transmit data without an external request. The passive devices, known as slaves, do not 
receive any bus access rights; they acknowledge messages received, or respond to a query from a 
master. Baud rates from 9.6 kBaud to 12 MBaud are supported.  A maximum of 126 devices can be 
operated on the bus. 

Data exchange 

This is handled predominantly in cyclical mode be-tween master and slave. The requisite communication 
functions have been specified by the PROFIBUS DP basic functions in accordance with EN 50170. Each 
master has full write and read access to its assigned slaves, but only read access to the slaves assigned 
to other bus masters. There is no direct data exchange between masters. Acyclical services (DP-V1) for 
parameterization and diagnostics between master and slave are also available. This is performed in 
parallel to the master’s cyclical user data traffic. 

PROFIBUS DP – the functionality at a glance  

• Max. 126 subscribers via amplifier and max. 32 subscribers (master/slaves) per bus segment  
• Data transmission rate from max. 12 MBit/s with a cable length of 100 m, up to 93.75 kBit/s with 1200 m  
• Multi-master or master/slave communication. Bus access of the masters using token  
• Connection of the master CPU and the associated communication module via a 9-pole SUB-D plug 
  connector. Connection of slaves (CPU, I/Os and intelligent switching devices) via FieldBusPlug 
• The system cable is a shielded twisted-pair line or a fiber-optic cable; transmission standard EIA RS485 

Diagnostics  

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called 
using the programming tool. In addition, the device status is indicated at the communica-tion module by 
four LEDs. 
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Documentation overview 

The documentation consists of six parts: 

• CoDeSys programming system - Describes the functionality of the programming software 
• Target system - Documentation of the AC500 system 
• CoDeSys libraries 
• CoDeSys visualization 
• CoDeSys HMI 
• CoDeSys license management 

CoDeSys programming system 

Section Comment 

A brief introduction to CoDeSys - Explanation of the acronym 'CoDeSys' 
- Software functionality 
- Components of a project 
- Programming languages 
- Debugging 

We write a little program - Controlling a traffic signal unit 
- Visualizing a traffic signal unit 

The individual components - Main window and functions 
- Options for project organization 
- Object handling (blocks, data types, visualizations, 
resources) 
- Editing functions 
- Online functions 
- Explanation of the help system 

Editors in CoDeSys - General 
- Declaration editor for the variables 
- Pragma instructions for controlling the compilation 
process 
- Text editor for instruction list and structured text 
- Graphical editors for sequential function chart, ladder 
diagram, function block diagram and free-graphic 
function block diagram editor 

The resources - PLC configuration 
- Global variables 
- Alarm configuration 
- Library manager 
- Logging (chronological recording of actions during 
online session) 
- Task configuration 
- Watch and recipe manager 
- Workspace (image of the project options set) 
- Target system settings 
- Target specific resources 

ENI revision control ENI (engineering interface for accessing an external 
project database from the programming system) 

IEC operators and additional norm-
extending functions 

- Arithmetic operators (ADD, MUL, SUB, ...) 
- Bitstring operators (AND, OR, XOR, NOT) 
- Bitshift operators (SHL, SHR, ROL, ROR) 
- Selection operators (SEL, MAX, MIN, LIMIT, MUX) 
- Comparison operators (GT, LT, LE, GE, EQ, NE) 
- Address operators (ADR, ADRINST, BITADR, content 
operator) 
- Calling operator (CAL) 
- Type conversions 
- Numeric operators (ABS, SQRT, LN, LOG, ...) 
- Initialization operator (INI) 
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Section Comment 

Operands in CoDeSys - Constants 
- Variables 
- Addresses 
- Functions 

Data types in CoDeSys - Standard data types 
- Defined data types 

Overview of operators and library blocks   

Command line / command file commands - Commands provided when CoDeSys is started 
- Command set for building a command file (Cmdfile) 

Use of keyboard - Operating CoDeSys using the keyboard only 
- Key combinations 

Siemens import (not available) Commands for importing blocks and variables from 
Siemens STEP5 files 

DDE communication Using the DDE interface (Dynamic Data Exchange) 

Keywords in CoDeSys Reserved keywords in CoDeSys (ABS, ACOS, ADD, ...) 

CoDeSys files Files generated by CoDeSys 

Compiler errors and warnings Information about possible error and warning messages 
displayed in the message window during project 
compilation. 

  
 

Documentation for the AC500 system 

Section Comment 

Introduction - Overview:  Here you can gain an overview of the 
AC500 system. This section provides further useful 
information. 
- First steps when working with AC500 and S500-FBP; 
examples 
- For AC1131 experts 

Your tasks - Documentation from the user's 
point of view 

- Engineering company 
- Sales and export 
- Control cabinet building and construction 
- Commissioning 
- Program creation 
- Operation, service and maintenance 
- Training and education 
- Callcenter, helpline 

AC500 hardware - System data 
- CPU terminal bases and terminal units 
- CPUs 
- Communication modules 
- CS31 modules 
- FBP interface modules 
- Digital input and output modules 
- Analog input and output modules 
- Accessories 

S500-FBP hardware (system description) - System data and system structure 
- Terminal units 
- FBP interface modules 
- Digital input and output modules 
- Analog input and output modules 
- Accessories 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-17  AC500 / Issued: 07.2006 

Section Comment 

Block libraries - System libraries 
- Modbus library 
- Series 90 AC500 library 
- ASCII communication library 
- CS31 library 
- Ethernet library 
- PROFIBUS DP library 
- CANopen library 
- DeviceNet library 
- DC541 library 

System technology - Basic units 
- Couplers 
- I/O modules 

OPC OPC (Object Linking and Embedding) for Project 
Control - a standardized interface for accessing 
process data 

 

CoDeSys libraries 

Section Comment 

'Standard.lib' library Standard library 

'util.lib' library Various blocks, e.g. for BCD conversion, bit/byte 
functions, etc. 

'AnalyzationNew.lib' library Analysis of expressions 

CoDeSys system libraries Depends on the target system 

 

CoDeSys visualization 

Section Comment 

Creating a visualization object A CoDeSys project block. The project block 
contains a set of visualization elements and can 
have specific properties as one complete object 

Inserting visualization elements E.g. rectangle, curve, button, etc. 

Positioning visualization elements Selecting, copying, modifying, etc. of visualization 
elements 

Configuring the visualization, visualization 
elements or visualization objects 

- Configuring the visualization - Overview 
- Configuring selected elements using 
configuration dialogs 
- Summarizing graphical elements to one 
visualization object which can have specific 
parameters assigned 

Visualization in online mode With operation by keyboard (configurable) 

Visualizations in libraries Storage of visualizations in libraries 
  

System variables within the visualization Implicitly created system variables for 
programming visualizations 

Possible key combinations For operation by keyboard 
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CoDeSys HMI 

Section Comment 

Overview Runtime system for execution of visualizations 

Installation, starting and operation - Program which has to be purchased and 
installed separately 
- Notes regarding start from command line 
- Operation by keyboard/mouse via visualization 
elements 

 

CoDeSys license management (not available) 

Section Comment 

Overview License management using the tool 

Creating a module which is subject to licensing Using the command 'File -> Save as -> Edit 
License Information dialog' 
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Short description of the hardware 

Example of an AC500 system. 

 

1. Back-lighted LCD display and keypad 

2. SD card slot 

3. Plug-in communication modules (1 to max. 4) 

4. Optionally with integrated Ethernet or ARCNET 

5. FBP interface (for slave) 

6. Two serial interfaces for programming, ASCII, 
Modbus or CS31 field bus (master) 

7. Expandable by up to seven local I/O modules 

Figure: AC500 system, module arrangement beginning from the left: communication module, CPU, I/O 
module 

CPUs 

Available in three performance classes: 

• PM571 (64kB memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31 (COM1), 1 x FBP) 
• PM581 or PM582 (256kB or 512kB  memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31 
  (COM1), 1 x FBP) 
• PM591 (4MB memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31 (COM1), 1 x FBP) 

All three types are also available with an integrated Ethernet coupler (TCP/IP). 

Communication modules 

For connection to standard field bus systems and integration into existing networks. 

Ethernet coupler supporting the protocols TCP/IP, UDP/IP and Modbus TCP. 

Coupler for fieldbus systems – PROFIBUS DP, DeviceNet and CANopen. 

Up to four communication modules in any desired combination are allowed at one CPU. 

The CPU terminal base 

For easy plug-in mounting of a CPU and one, two or four communication modules (three types available 
accordingly). 

The I/O modules 

Digital and analog in different versions. Can be simply plugged onto the terminal units – for local 
expansion of the CPU (max. seven modules) and decentralized expansion via the FBP interface (max. 
seven modules, thereof max. four analog modules). Flexible use thanks to configurable channels. 

The I/O terminal units 

Multi-purpose usage for both digital and analog I/Os, for 1, 2 and 3-wire designs. Enable simple 
prewiring without electronics. For 24 V DC and 230 V AC, optionally for spring or screw-type terminals. 

The FBP interface module   
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With embedded digital I/Os and a field-bus-neutral interface for connecting the chosen FBP connector. 
For decentralized expansion by up to seven I/O modules.   

The SD card  

The SD memory card is used for the following purposes: Backup of user data, storage of the user 
program, storage of the project’s source code, update of the internal CPU firmware. 

 
 

Short description of the software 

  

 

  

Programming in conformity with IEC 61131-3 

AC500 Control Builder provides the following functionalities: 

■ Five standardized programming languages: Function Block Diagram (FBD), Instruction List (IL), 
Ladder Diagram (LD), Structured Text (ST), Sequential Function Chart (SFC)   

■ Free graphical function chart (CFC)  

■ Debugging functions for the program test: Single step, Single cycle, Breakpoint 

Offline simulation   

IEC 61131-3 commands can be simulated without a PLC being connected, including the relevant 
malfunctions. After the program test, the application can be downloaded to the control system. 

Sampling trace   

Timing diagrams for process variables and storage of data in a ring buffer with event trigger. 

Recipe management and watch lists   

Values of selected variables are displayed. Pre-defined values can be assigned to variables which can 
then be downloaded to the control system all at once (“Write recipe”). Ongoing values from the control 
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system can also be pre-assigned for reading into the Watch and Recipe Manager, and stored in memory 
there (“Read recipe). These functions are also helpful, for example, for setting and entering control 
parameters.  

Visualization  

Includes color change, moving elements, bitmaps, text display, allows input of setpoint values and 
display of process variables read from the PLC, dynamic bar diagrams, alarm and event management, 
function keys and ActiveX elements. 

Configurators of the communication interfaces   

Integrated field bus configurator SYCON.net for PROFIBUS DP, CANopen, DeviceNet, Ethernet, 
Modbus and CS31.   

Open interfaces   

DDE and OPC.  

Programming   

Serial or via Ethernet or ARCNET networks.  

Engineering interface   

Provides access from the programming system to an external project database in which the program 
source code of one or several automation projects is managed. Optionally, a version control system, 
such as Visual Source Safe, can be used in order to ensure data consistency of the program code for 
several different users and projects. 

• Comprehensive libraries.  
• Windows 32-bit standard.  
• Operating systems Windows 2000 and XP.  
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Operating and displaying 

The AC500 offers as well an extensive range of products for communication between operator and 
machine. There are many different displays to choose from, which satisfy application-specific demands 
regarding required operator actions and information density. 

Users can communicate with the AC500s CPUs via the various operator panels, read and write access 
on device data is possible. Configuration is quick and easy to perform, using the same software for all 
devices (programming software CPsoft, 1SBS 260 283 R1001). Commands and programming 
languages are identical for all devices. With regard to frequently harsh conditions at the place of 
installation, all operator panels fulfill IP65 protection at the front. Operator panels and automation 
devices are linked either simply via serial interfaces, or in case of complex applications via Ethernet, 
Modbus or PROFIBUS DP. 
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Overview of CP500 operator panels - part 1 

  

  

 

 
 

Type CP501 CP502 CP503  CP511 CP512 

Order Number 1SBP 260 170 
R0101   

1SBP 260 171 
R0101 

1SBP 260 172 
R0101 

1SBP 260 173 
R0101 

1SBP 260 174 
R0101 

Display type 
  

STN LCD 
with backlight 

STN LCD 
with backlight 

STN LCD 
with backlight 

STN LCD 
with backlight 

B/W STN LCD 
with backlight 

Representation Text Text Text Grafic and text Grafic and text 

Display size 2 lines x 16 
characters 

2 lines x 20 
characters 

4 lines x 20 
characters 

240 x 64 pixels 
(5.2") 

240 x 128 
pixels (5.3") 

Display area 
W x H (mm) 

55,7 x 11,0 73,5 x 11,5 70,4 x 20,8 127,2 x 33,9 120,0 x 64,0 

Text height 
(mm) 

5 5 5 variable variable 

LEDs     5 (2 colors)   16 (2 colors) 16 (2 colors) 

Function keys 4 3 5 8 16 (8 with 
labeling strip) 

Web functions       x x 

Buzzer       x x 

Alarm 
management 

    1 group 4 groups 4 groups 

Time channel   x x x x 

Real-time 
clock 

  x x x x 

Trend curves       real-time developing of 
values 

Data logger           

Recipe 
management 

  x x x x 

Report printing   x x x x 

Password 
protection 

  8 levels 8 levels 8 levels 8 levels 

Multilanguage 
support 

  x x x x 

 Application 
memory 

16 kB Flash    64 kB Flash  64 kB Flash 400 kB Flash 400 kB Flash 

Power supply 24 V DC 24 V DC 24 V DC 24 V DC 24 V DC 

Current 
consumption 

200 mA 150 mA 150 mA 450 mA 450 mA 

Ambient 
temperature 

0 - 50 °C 0 - 50 °C 0 - 50 °C 0 - 50 °C 0 - 50 °C 
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Type CP501 CP502 CP503  CP511 CP512 

Communication 
interfaces 

RS232 or 
RS422    

RS232, RS422 
RS485 (of which 2 
at the same time) 

RS232, RS422 RS232, RS422 RS232, RS422 

Expansion 
slots 

- - - 1 1 

Degree of 
protection 
front cover 

IP65 IP65 IP65 IP65 IP65 

Dimensions 
W x H x D 
(mm) 

104 x 69 x 38 
    

142 x 100 x 29 147 x 163,5 x 
38 

211 x 198 x 69 214 x 232 x 87 

Weight (kg) 0.2    0.5  0.7 1.5 1.4 
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Overview of CP500 operator panels - part 2 

  

 
    

Type CP513 CP551 CP552 CP554 CP555 

Order Number 1SBP 260 175 
R0101 

1SBP 260 176 
R0101 

1SBP 260 177 
R0101 

1SBP 260 178 
R0101 

1SBP 260 179 
R0101 

Display type TFT 256 Color 
LCD with 
backlight 

Touch B/W 
STN 

with backlight 

16 grey levels 
Touch LCD 

with backlight 

TFT 256 Color 
touch LCD 

TFT 256 Color 
touch LCD 

Representation Grafic and text Grafic and text Grafic and text Grafic and text Grafic and text 

Display size 320 x 240 Pixel 320 x 240 Pixel 320 x 240 Pixel 320 x 240 Pixel 640 x 480 Pixel 

Display area  
W x H (mm) 

115,2 x 86,4    78,0 x 58,5 115,2 x 86,4 115,2 x 86,4  211,2 x 158,4 

Text height 
(mm) 

variable variable variable variable variable 

LEDs 16 (2 colors)         

Function keys 16 (8 with 
labeling strip) 

        

Web functions x x x x x 
Buzzer x x x x x 
Alarm 
management 

16 groups 4 groups 5 groups 5 groups 11 groups 

Time channel x x x x x 
Real-time clock x x x x x 
Trend curves developing of 

values 
developing of 

values 
developing of 

values 
developing of 

values 
developing of 

values 

Datalogger x x x x x 
Recipe 
management 

x x x x x 

Report printing x x x x x 
Password 
protection 

8 levels 8 levels 8 levels 8 levels 8 levels 

Multilanguage 
support 

x x x x x 

Application 
memory 

400 kB Flash 400 kB Flash 400 kB Flash 400 kB Flash 1600 kB Flash 

Power supply 24 V DC 24 V DC 24 V DC 24 V DC 24 V DC 

Current 
consumption 

550 mA     450 mA 400 mA 450 mA 1 A 

Ambient 
temperature 

0 - 50 °C 0 - 50 °C 0 - 50 °C 0 - 50 °C 0 - 50 °C 

Communication 
interfaces 

RS232, RS422 
  

RS232, RS422 
RS485, 
Ethernet 

(of which 2 at 
the same time) 

RS232, RS422 
RS485  

(of which 2 at 
the same time) 

RS232, RS422 
RS485 

(of which 2 at 
the same time) 

RS232, RS422 

Expansion slots 2 - 1 1 2 

Degree of 
protection 
front cover 

IP65 IP65 IP65 IP65 IP65 

Dimensions 
W x H x D (mm) 

276 x 198 x 89 
   

 138 x 100 x 30 200 x 150 x 69 200 x 150 x 69 290 x 250 x 
105 

Weight (kg) 1.7 1.4 1.5 1.5 3.3 
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Services 

Service - Control Engineering 

ABB operates a Technical Support Center to assist with even the most difficult of problems. 

• Consultation by phone (Helpline) 
• Failure analysis and removal at the machine/installation 

 
In order to provide the customer with qualified assistance, customers are requested to provide the 
following: 

• Provide all required application documentation and information. 
• Provide access (if required) to the system being examined. 
• Assign key individuals to assist as required. 

For inquiries and orders, please contact: 

ABB STOTZ-KONTAKT GmbH 
Dept. STO/CPT, Control Engineering Helpline 
Eppelheimer Straße 82 
D-69123 Heidelberg 
  
Postfach 10 16 80 
D-69006 Heidelberg 
  
Phone +49 6221 701-1444 
Telefax +49 6221 701-1382 
  
E-mail: desst-helpline.desto@de.abb.com 

  

For further information about control engineering please also refer to our Internet Website 
http://www.abb.de/stotzkontakt. 

Repair services and replacement devices 

The following services are also covered by our activities: 

• Delivery of replacement devices 
• Repair of defective devices and systems 

 
Please contact your responsible sales office for your inquiry. 
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Seminars/Workshops 

 

We also offer seminars and workshops to support you in planning, commissioning and operation of 
Advant Controller AC500 controls. Please contact: 

ABB STOTZ-KONTAKT GmbH 
Dept. STO/VPS 
Eppelheimer Straße 82    Postfach 10 16 80 
D-69123 Heidelberg         D-69006 Heidelberg 
Phone +49 6221 701-1202 or -1205 
Telefax +49 6221 701-1361 
E-mail: Dieter.Druschke@de.abb.com or Heinrich.Happle@de.abb.com 

If desired, we also offer seminars at the customer's facility. Please find detailed information in our 
seminar brochure. You can order this brochure from the address given above or from every ABB 
STOTZ-KONTAKT GmbH office or you can download it from our Internet website (PDF file, see the 
following link). 

Please send your enrolment directly to ABB STOTZ-KONTAKT GmbH using the address given above or 
via Internet (http://www.abb.de/stotzkontakt -> Schulungen und Seminare -> Seminare). 

If necessary, it is also possible to arrange the seminar contents according to the customer's wishes. 
Depending on the special requirements, the training can be held in Heidelberg or at any other location 
favored by the customer. We are pleased to prepare an individual offer for you according to your special 
requirements. 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-28  AC500 / Issued: 07.2006 

 

Addresses 

ABB STOTZ-KONTAKT GmbH 
P.O. Box 10 16 80 
D-69006 Heidelberg 
Telephone: ++49 62 21 / 701-0 
Telefax: ++49 62 21 / 701-729 
  
http://www.abb.de/stotz-kontakt 

  

ABB Entrelec - Control Division 
184, rue Léon Blum 
F-69100 Villeurbanne / France 
Telephone: ++33 (0) 4 72 35 35 
Telefax: ++33 (0) 4 72 35 12 
  
http://www.abb.com/lowvoltage 
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Regulations concerning the appropriate and safe setup of systems and 
installations 

Apart from the basic „Regulations for the Setting up of Power Installations“ DIN VDE* 0100 and for „The 
Rating of Creepage Distances and Clearances“ DIN VDE 0110 Part 1 and Part 2 the regulations „The 
Equipment of Power Installations with Electrical Components“ DIN VDE 0160 in conjunction with DIN 
VDE 0660 Part 500 have to be taken into due consideration. 

To insure project success and to insure that all systems are properly and safely installed, the customer 
must be familiar and proficient with the following standards and must comply with their directives: 

• Working & Process Machinery:  DIN VDE 0113 Part 1 & Part 200 
• Close proximity to dangerous voltages:  DIN VDE 0106 Part 100 
• Protection against direct contact: DIN VDE 0160, DIN VDE 0110 Part 1 

The user has to guarantee that the devices and the components belonging to them are mounted 
following these regulations. For operating the machines and installations, other national and international 
relevant regulations, concerning prevention of accidents and using technical working means, also have 
to be met. 

Advant Controller Devices are designed according to:  IEC 1131 Part 2 under overvoltage category II per 
DIN VDE 0110 Part 2. 

For direct connection of AC Category III overvoltages provide protection measures for overvoltage 
category II according to IEC-Report 664/1980 and DIN VDE 0110 Part 1. 

Equivalent standards: 

DIN VDE 0110 Part 1 ↔ IEC 664 

DIN VDE 0113 Part 1 ↔ EN 60204 Part 1 

DIN VDE 0660 Part 500 ↔ EN 60439-1 ↔ IEC 439-1 

All rights reserved to change design, size, weight, etc. 

* VDE stands for „Association of German Electrical Engineers“. 

Safety technical instructions 

Please read! 

General 

Completely safe installation and starting up and problemfree functioning of the devices at their work 
location can be ensured by observing the following instructions. 

Qualified personnel 

Both the control system AC500 and other components in the vicinity are operated with dangerous 
contact voltages. Touching parts, which are under such voltages, can cause grave damage to health. 

In order to avoid such risks and the occurrence of material damage, everyone involved with the 
assembly, starting up and servicing must possess pertinent knowledge of the following: 

• the automation technology sector, 
• dealing with dangerous voltages, 
• using standards and regulations, in particular VDE, accident prevention regulations and regulations 

concerning special ambient conditions (e.g. areas potentially endangered by explosive materials, 
heavy pollution or corrosive influences). 
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Use as directed 

Properly installed systems that are "used as directed" and properly conform with the applicable codes, 
regulations and sound engineering principles pose no risks or dangers to health. 

"Used as directed" implies that the devices are installed, maintained and operated in accordance with 
appropriate ABB manuals & documents. 

No liability is assumed for the direct or indirect consequences of the improper use, improper application 
or inadequate maintenance of these devices. 

Risk reduction instructions 

 
Protect the devices from dampness, dirt and damage during transport, storage 
and operation! 

 
Do not operate devices outside of the specified, technical data! 

Trouble-free functioning cannot be guaranteed outside of the specified data. 

 
Operate the control system only in an enclosed housing (switch cabinet)! 

Due to their construction (degree of protection IP 20 according to EN 60529) and their connection 
technology, the devices are suitable only for operation in enclosed housings (switch cabinets). 

 Earth the devices! 

The earthing (switch cabinet earthing, PE) is supplied both by the mains connection (or 24 V supply 
voltage) and via DIN rail. 

The DIN rail must be connected to the earth before the device is subjected to any power. The earthing 
may be removed only if it is certain that no more power is being supplied to the control system. 

In the description for the devices (operating manual or AC500 system description), reference is made at 
several points to earthing, electrical isolation and EMC measures. One of the EMC measures consists of 
discharging interference voltages into the earthing via Y-type capacitors. Capacitor discharge currents 
must basically be able to flow off to the earthing (in this respect, see also VBG 4 and the relevant VDE 
regulations). 

In the description, special attention must be paid to designs using electrical isolation, earthing and EMC 
measures for the reasons stated. For more information see Target System -> AC500/S500-FBP -> 
Hardware AC500 -> System data -> General considerations for EMC-conforming assembly and 
construction. 

The earthing concept of these busses apply to the connection to external bus systems. 

 Connection of the supply voltage 

The supply voltage (or mains connection) terminal block must only be plugged in or withdrawn with the 
power off! 

The same applies to the terminal blocks of input or output channels (e.g. relay outputs) if they are 
operated with dangerous contact voltages. 

 Do not open live devices! 

The devices work with voltages with which contact must be avoided under all circumstances. Therefore 
they must not be opened when live. The same applies to the networking interfaces. 

Lifting up the cover of the battery compartment to exchange the battery module is not construed as 
opening in this context. 
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 Do not obstruct the ventilation for cooling! 

The ventilation slots on the upper and lower side of the devices must not be covered by wiring, cable 
ducts and things like that. 

 Run signal and power wiring separately! 

Signal and supply lines (power cables) must be laid out so that no malfunctions due to capacitive and 
inductive interference can occur (EMC). 

 Precautions against wiring short-circuits and breakages 

Connection plans and user software must be created so that all technical safety aspects, legal 
regulations and standards are observed. In practice, possible shortcircuits and breakages must not be 
able to lead to dangerous situations. The extent of resulting errors must be kept to a minimum. 

 Use only ABB approved lithium battery modules! 

At the end of the battery’s lifetime, always replace it only with a genuine battery module. 

 Never short-circuit or operate lithium batteries with the polarities reversed! 

They are likely to overheat and explode. Avoid chance short circuiting and therefore do not store 
batteries in metal containers and do not place them on metallic surfaces. Escaping lithium is a health 
hazard. 

 Never charge lithium batteries! 

Lithium batteries are primary cells and cannot be recharged. Attempts to charge lithium batteries lead to 
overheating and possible explosions. 

 Dispose of lithium batteries environmentally consciously! 

Do not open lithium batteries and never throw them into fires (risk of explosion). Do not dispose of along 
with the household rubbish but in an environmentally conscious manner, in accordance to local-authority 
regulations. 

Additional notes 

 ATTENTION 
Avoidance of electrostatic charging 
  
Electrostatic charging can cause internal defects of the devices and impair the 
proper function. Observe the following rules when handling the system: 

• Touch an earthed object in order to discharge the electrostatic 
charging. 

• Wear a suitable earthed strap around your wrist. 

• Do not touch any connections or pins on the printed circuit boards. 

• Do not touch any circuits inside the devices. 

• If available, use a work place which is equipped with suitable 
electrostatic discharge. 

• In order to avoid electrostatic charging, the devices must only be 
stored when packed in suitable packaging material. 

Minimum clearances: Refer to target system - AC500/S500-FBP -> Introduction -> Getting Started -> 
Getting Started with AC500 -> Assembling the system 

ABB STOTZ-KONTAKT GmbH Heidelberg 
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Getting started with AC500 

Important User Information 

Solid state equipment has operational characteristics differing from those of electromechanical 
equipment. Because of this difference, and also because of the wide variety of uses for solid state 
equipment, all persons responsible for applying this equipment must satisfy themselves that each 
intended application of this equipment is acceptable. 

In no event will ABB be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the 
many variants and requirements associated with any particular installation, ABB cannot assume 
responsibility or liability for actual use based on the examples and diagrams. 

No patent liability is assumed by ABB with respect to use of information, circuits, equipment, or software 
described in this manual. 

Throughout this manual we use notes to make you aware of safety considerations. 

 WARNING 
Identifies information about practices or circumstances that can cause an 
explosion in a hazardous environment, which may lead to personal injury or 
death, property damage, or economic loss. 

 IMPORTANT 
Identifies information that is critical for successful application and 
understanding of the product. 

 ATTENTION 
Identifies information about practices or circumstances that can lead to 
personal injury or death, property damage, or economic loss. Attentions help 
you: 

• identify a hazard 
• avoid a hazard 
• recognize the consequence 

SHOCK HAZARD Labels may be located on or inside the device to alert people that dangerous 
voltage may be present. 

SHOCK HAZARD Labels may be located on or inside the device to alert people that surfaces may 
have dangerous temperatures. 

Environment and Enclosure Information 

 ATTENTION 
Environment and Enclosure 
 
This equipment is intended for use in a Pollution Degree 2 industrial 
environment, in overvoltage Category II applications (as defined in IEC 
publication 60664-1), at altitudes up to 2000 meters without derating. 
 
This equipment is considered Group 1, Class A industrial equipment according 
to IEC/CISPR Publication 11. Without appropriate precautions, there may be 
potential difficulties ensuring electromagnetic compatibility in other 
environments due to conducted as well as radiated disturbance. 
 
This equipment is supplied as "open type" equipment. It must be mounted 
within an enclosure that is suitably designed for those specific environmental 
conditions that will be present and appropriately designed to prevent personal 
injury resulting from accessibility to live parts. The interior of the enclosure must 
be accessible only by the use of a tool. Subsequent sections of this publication 
may contain additional information regarding specific enclosure type ratings 
that are required to comply with certain product safety certifications. 
 
See NEMA Standards publication 250 and IEC publication 60529, as 
applicable, for explanations of the degrees of protection provided by different 
types of enclosure. Also, see the appropriate sections in this publication, as 
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well as the S500 User's manual for additional installation requirements 
pertaining to this equipment. 

Before starting 

Use this document as a guide for installing and powering-up your AC500 PLC. You should already be 
familiar with the system components. 

How to handle AC500 components 

 ATTENTION 
Preventing Electrostatic Discharge 
 
This equipment is sensitive to electrostatic discharge, which can cause internal 
damage and affect normal operation. Follow these guidelines when you handle 
this equipment: 

• Touch a grounded object to discharge potential static. 
• Wear an approved grounding wrist strap. 
• Do not touch connectors or pins on component boards. 
• Do not touch circuit components inside the equipment. 
• If available, use a static-safe workstation. 
• When not in use, store the equipment in appropriate static-safe 

packaging.  

Make sure that you have all the components you need 

To use the AC500 PLC (in our example CPU PM581-ETH) you should use at least the following parts: 

Part Number Designation 

1SAP 1121 00 R0170 TB521-ETH Terminal Base for CPU with 2 coupler slots 

1SAP 1401 00 R0170 PM581-ETH CPU 

1SAP 1806 00 R0001 TA524 Dummy coupler module  to cover the unused coupler slots 

1SAP 1802 00 R0001 TK501 Programming Cable D-Sub / D-Sub 

 

Optional: 

Part Number Designation 

1SAP 1803 00 R0001 TA521 Lithium Battery 

1SAP 1801 00 R0001 MC502 Memory SD-Card 
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  You can use the following components to add additional I/O modules: 

If you want … … use the following component(s): 
• to connect a digital 24 VDC sensor or 

actuator to the CPU … 
DI524 (32 DI ), DC522 (16DC), DC523 (24DC), 
DC532 (16DI/16DC) or  DX522 (8DI/8 DO-R) with 
the corresponding terminal unit with screw or 
spring connection TU515/516 or TU531/532 

• to connect a 115-230 VAC sensor or 
actuator to the CPU ... 

DX531 (8DI 115-230 V AC / 4 DO-R) + 
corresponding Terminal Unit TU531/532 with 
screw or spring technology 

• to connect an analog 24 VDC sensor or 
actuator to the CPU … 

AI523 (16AI U/I/PT100), AO523 (16AO), AX521 
(4AI/4AO U/I/PT100) or AX522 (8AI/8AO 
U/I/PT100) + corresponding Terminal Unit 
TU515/516 

• to label the I/O channels … TA523 (Pluggable Marking Holder) + TA525 Set 
of Plastic Markers 

The following components are recommended for fieldbus communication: 

If you want … … use the following component(s): 
• the system to act as a master on 

PROFIBUS DP, DeviceNet or CANopen 
fieldbuses … 

CM572-DP for PROFIBUS DP, CM575-DN for 
DeviceNet or CM578-CN for CANopen 

• the system to act as a slave on 
PROFIBUS DP, DeviceNet or CANopen 
fieldbuses … 

FieldBusPlug standard plugs like PDP22-FBP 
(PROFIBUS DP slave) or DNP21-FBP 
(DeviceNet) or other one’s 

• to exchange data via the network … CM577-ETH to achieve Ethernet TCP/IP 
communication with integrated 2-ports switch 

System planning 

Consider the following when planning your AC500 system: 

• The AC500 PLC consists of a CPU Terminal Base TB5xx (from 1 to 4 coupler slots) and a pluggable 
CPU. Three different CPU classes are offered: from PM571 with 64kB memory up to PM591 with 
4MB memory; available also with integrated Ethernet coupler. 

• Proper CPU Terminal Base selection requires that sufficient slots are available for all current or 
future network and fieldbus communication modules (e.g. Ethernet, ARCNET, PROFIBUS, etc.) if 
required. 

• Up to 4 communication couplers can be connected to the CPU through the dedicated CPU terminal 
base.  

• All types of external communication couplers can be used together in the same time but only up to 4 
external couplers in total (e.g. a mix of coupler types like Ethernet + Ethernet + Profibus DP + 
CANopen, etc …). 

• The total number of communication couplers (internal + external) is limited to 5. 
• The CPU terminal base is always the left-most device in the system.  
• An external 24 Vdc power supply has to be provided to the CPU Cluster; the additional I/O modules 

have to be installed to the right of the PLC module.  
• The AC500 PLC module supports as many as 7 local I/O expansion modules.  
• An additional process power supply has to be provided for the I/Os of each module. Each I/O 

expansion module can be powered with its own power supply (for isolation purposes) or the same 
power supply can also be used. 

• One FieldBusPlug can be plugged directly into an AC500 PLC cluster 
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Steps for installation 

√   Installation step: Further 
information: 

 1 Snap the AC500 PLC Terminal Base onto DIN Rail or wall-mount with 
screws. 

 

 2 Snap the additional Terminal Units for I/O modules onto DIN Rail 
(optional) or screw them (wall mounting). 

 

 3 Make the sensor/actuator wire connections according to the dedicated 
Electronic module you want to use. Provide external process power 
supply as required. 

(*) 

 4 If required, make the fieldbus connections according to the dedicated 
master coupler module you want to use. 

(*) 

 5 Plug the appropriate electronic and I/O modules in the correct locations 
(CPU module, communication couplers on TB, and eventually also I/O 
modules onto dedicated TUs). 

 

 6 Install the battery and the memory SD card; this is optional and the 
CPU is able to run without them. 

 

 7 If required, make the FBP fieldbus slave connection according to the 
chosen FBP and use the dedicated FBP accessories (cables, master 
cable to M12, line termination, power supply connector, etc…). 

(**) 

 8 If required, plug the FBP-Plug on the M12 connector located on the 
CPU Terminal Base of the AC500 PLC. 

  

 9 Connect a programming cable (e.g. TK501 in COM2/PLC and 
COM1/PC; TK502 is necessary for COM1/PLC) on the PC and on the 
AC500 PLC. 

  

 10 Set the power on (process power supply first and PLC power supply).   

 11 If required, set the an address for the integrated Ethernet 
communication interface by using the front face LCD Display + 
keyboard of the CPU module (see the  dedicated chapter of the user’s 
manual). 

  

 12 Install the AC500 Control Builder programming software on your PC. If 
required, also copy the appropriate EDS/GSD files into the Fieldbus 
configurator (AC500 Control Builder) to manage the possible fieldbus 
slave modules connected to the AC500 master couplers. 

(*) 

 13 Program the hardware configuration.   

(*)  Refer to the AC500 hardware description for proper wiring and addressing information. 

(**) Refer to the Installation Instructions for the particular FBP devices. Follow appropriate fieldbus 
practices outline by the conventions and standards of each protocol used in the system. 
 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-36  AC500 / Issued: 07.2006 

Assembling the system 

 WARNING 
The AC500 modules are not designed for removal or insertion under power. 
Because of unforeseeable consequences, it is not allowed to plug or unplug 
modules with the power being ON. 
  
Disconnecting the FBP or any powered modules while energized in a 
hazardous location could result in an arc, which could create a flammable 
ignition resulting in a fire or explosion. 
  
Be sure that power is removed and that an area has been thoroughly checked 
to insure that flammable materials are not present prior to proceeding. 

Using S500 I/O Modules 

The S500 I/O modules could be used either directly connected to an AC500 CPU (central expansion) or 
together with an FBP Interface Module DC505-FBP + an FBP (PROFIBUS DP, DeviceNet, etc.) as 
decentralized expansion. 

DC532DC532PM581CM577CM572

 

Figure: S500 I/O modules directly connected to an AC500 CPU (central I/O expansion) 
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DC532DC532DC505

 

Figure: S500 I/O modules connected to an FBP Interface Module DC505-FBP with an FBP 
(decentralized expansion) 
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Minimum spacing 

DC532DC532DC505

DC532DC532PM581CM577CM572

DIN rail,
earthed

Mounting
plate,
earthed

DIN rail,
earted

Mounting
plate,
earthed

Cable duct

20 mm minimum distance between
the modules and the cable duct

 

 

Figure: AC500/S500 module mounting into cabinets 

Maintain spacing from enclosure walls, wireways, adjacent equipment, etc. Allow minimum 20 mm (1 in.) 
of space on all sides, as shown. This provides ventilation and electrical isolation. 
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 Important: Horizontal mounting is highly recommended. Vertical mounting is possible, 
however, derating consideration should be made to avoid problems with poor air circulation and the 
potential for excessive temperatures (see also the AC500 system data, operating and ambient 
conditions, for reduction of ambient temperature). 

 

 Note: By vertical mounting, always place an end-stop terminal block (e.g. type BADL, P/N: 
1SNA399903R0200) at the bottom and on the top of the modules to properly secure the modules. 

By high vibration applications and horizontal mounting, we also recommend to place end-stop 
terminals at the right and left side of the device to properly secure the modules, e.g. type BADL, 
P/N: 1SNA399903R0200. 

Insertion / replacement of the Lithium battery 

The CPU is shipped without a battery. Please order the TA521 lithium battery separately. The battery is 
used to retain data stored in the user’s RAM and in the Real Time Clock. Although the CPU can be used 
without any battery, it is recommended to install it to avoid process data loss. 

The CPU monitors the battery status. A low battery error is output before the battery condition becomes 
critical (about 2 weeks before). After the error message appears, the battery should be replaced as soon 
as possible. 

 ATTENTION 
The TA521 Lithium Battery is the only one, which can be used with AC500 CPUs. 

The following procedures describe the insertion / replacement of the Lithium battery. 

 

WARNING!
Use of

incorrect
battery may
cause fire or
explosion.

WARNING!
Use of

incorrect
battery may
cause fire or
explosion.

1a

2

3

4+5

WARNING!
Use of

incorrect
battery may
cause fire or
explosion.

6

1b

 

Figure: Insertion / replacement of the Lithium battery 
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Insertion of the battery: 

1. Open the battery compartment by inserting a fingernail in the small locking mechanism, press it 
down and slip down the door. The door is attached to the front face of the CPU and cannot be 
removed! 

2. Remove the TA521 battery from its package and hold it by the small cable. 

3. Insert the battery connector into the small connector port. The connector is keyed to find the correct 
polarity (red = plus pole = above). 

4. Bend the cable and insert first the cable and then the battery into the compartment, push it until it 
reaches the bottom of the compartment. 

5. Arrange the cable in order not to inhibit the door to close. 

6. Pull-up the door and press until the locking mechanism snaps. 

 NOTICE 
In order to prevent data losses or problems, the battery should be replaced after 3 
years of utilisation or at least as soon as possible after receiving the “Low battery 
Warning” indication. 
Don’t use a battery older than 3 years for replacement. Do not keep batteries too 
long in stock. 

Replacement of the battery: 

 ATTENTION 
In order to avoid any data losses (if needed), the battery replacement should be 
done with the system under power. Without battery and power supply there is no 
data buffering possible. 

1. Open the battery compartment by inserting a fingernail in the small locking mechanism, press it down 
and slip down the door. The door is attached to the front face of the CPU and cannot be removed. 

2. Remove the old TA521 battery from the battery compartment by pulling it by the small cable. Remove 
then the small connector from the socket, do this best by lifting it out with a screwdriver (see photo). 

 

3. Follow the previous instructions to insert a new battery. 

 ATTENTION 
  

Lithium batteries must not be re-charged, not be disassembled and not be 
disposed of in fire. They must be stored in a dry place. Exhausted batteries 
must be recycled to respect the environment. 

Please refer to chapter "Hardware/Accessories/TA521" for the technical data sheet of the Lithium battery 
TA521. 
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Insertion of the SD memory card 

AC500 CPUs are supplied without an SD Memory Card. It therefore must be ordered separately. The SD 
Memory Card is used to back-up user data and store user programs or project source codes as well as 
to update the internal CPU firmware. AC500 CPUs can be operated with and without SD Memory Cards. 

The CPU uses a standard file system, which allows the MC502 SD Memory card to be read with a 
standard memory card reader. 

 ATTENTION 
The use of memory cards other than the MC502 SD Memory Card is prohibited. 
ABB is not responsible nor liable for consequences resulting from use of 
unapproved memory cards. 

 

 ATTENTION 
In operation, the plugged-in SD Memory Card withstands vibrations up to 1 g. 
Without using an SD Memory Card, the CPU itself withstands vibrations up to 
4 g. 

 

SD Memory Card
MC502

ETH
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COM1
COM2

PWR RUN ERR
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INSERT
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24 V DC  10 W

WARNING!
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battery may
cause fire or
explosion.

 

Figure: Insertion of the SD Memory Card 

To insert the SD Memory Card, follow the procedure shown below. 

1. Remove the SD Memory Card from its package. 

2. Insert the memory card into the opening of the front face of the CPU with the memory card aligned 
as shown above (contacts are visible on the left side, bevelled edge below). 

3. Push on the card until it moves forward, then release your pressure, the SD card comes slightly 
backward and it locks into the SD card slot. 

Removing the SD Memory Card 

To remove the card, first push on the card until it moves forward (that unlocks the card), then release 
your pressure, the card will go forward out of the slot and can be easily removed. 

The technical data sheet for the SD Memory Card can be found in the chapter "Hardware / Accessories / 
SD Memory Card MC502". 
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Mounting the System 

 ATTENTION 
During panel or DIN rail mounting of all devices, be sure that all debris (metal 
chips, wire strands, etc.) is kept from falling into the controller. Debris that falls 
into the controller could cause damage while the controller is energized. 

Mounting and Demounting of the Terminal Base, the Terminal Unit and the Electronic 
Modules 

Mounting on DIN rail 

Step 1: Install the 7.5 mm or 15 mm DIN Rail  
Step 2: Snap the AC500 Terminal Base (TB5xx) 
 

 

Figure: Mounting of the AC500 Terminal Base (TB5xx) 

The AC500 Terminal Base will be placed on top of the DIN Rail and then snapped on the bottom. Follow 
the reverse order to disassembly. 

 

Figure: Disassembly of the CPU Terminal Base (TB5xx) or Terminal Unit (TU5xx)
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Step 3: Mounting of the I/O Terminal Unit (TU515, TU516, TU531 or TU532) to the CPU Terminal Base 

 

Figure: I/O Terminal Unit assembly (TU515, TU516, TU531 or TU532) 

The  I/O Terminal Unit is snapped into the DIN rail in the same way as the Terminal Base. Once secured 
to the DIN rail, slide the I/O unit to the left until it fully locks into place creating a solid mechanical and 
electrical connection. 

Up to 7 I/O Terminal Units could be combined with a CPU Terminal Base. 

 ATTENTION 
When attaching the CPU Terminal Base and I/O modules, make sure the bus 
connectors are securely locked together to ensure proper electrical connection. 

1 7...

 

Figure: Maximum configuration (1 CPU Terminal Base plus 7 I/O Terminal Units) 
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Disassembly of a Terminal Unit 

 

Figure: CPU Terminal Base (TB5xx) or I/O Terminal Unit disassembly (TUxx) 

A screwdriver is inserted in the indicated place to separate the Terminal Units. 

Step 4: CPU or Electronic Module assembly 

PM581

 

Figure: Mounting of the CPU (PM5xx) on a Terminal Base (TB5xx), in the same way as I/O modules on 
Terminal Units 

The CPU or I/O module will be plugged on the dedicated Terminal Base / Terminal Unit. And will be 
locked in place. The disassembly is done in reverse order. 
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1
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1

 

Figure: CPU / I/O Module disassembly 

For disassembly, press top and bottom, then pull out the CPU / I/O module. 

Step 5: Communication Couplers on Terminal Base assembly 

 

Figure: Mounting of a communication coupler (CM5xx) on a CPU Terminal Base (TB5xx) 

First insert the bottom nose of the communication Coupler module into the dedicated holes of the 
Terminal Base and then rotate the coupler until it will be plugged on the dedicated Terminal Base slot, 
push to be sure that the connection is well done. It will be locked in place. 

The disassembly is done in reverse order. 
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1
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Figure: Communication coupler module disassembly 

Disassembly: Press Top and Bottom, then rotate the coupler module and pull it out. 
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Panel mounting  

If the CPU Terminal Base should be mounted with screws, Wall Mounting Accessories TA526 must be 
inserted at the rear side first. These plastic parts prevent bending of the Terminal Base while screwing 
on. TB511 needs one TA526, TB521 and TB541 need two TA526. 

 

Holes for wall mounting

1

2

1

3

Rear view

Rear view

Front view

 

Figure: Fastening with screws of the Terminal Base TB521-ETH (as an example) 

1  The two Wall Mounting Accessories TA526 are snapped on the rear side of the CPU Terminal Base 
like DIN rails. The arrows point to the middle of the CPU Terminal Base. One TA526 is turned by 180°. 

2  Two accessories for wall mounting inserted 

3  CPU Terminal Base, fastened with screws. Use two screws per module (three for the TB). Use M4 or 
#8 pan head screws. Mounting screws are required on every module.  

By wall mounting, the CPU Terminal Base is earthed through the screws. It is necessary that 

• the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated) 
• the  mounting plate is earthed 
• the screws have a good electrical contact to the mounting plate 
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The following procedure allows you to use the assembled modules as a template for drilling holes in the 
panel. Due to module mounting hole tolerance, it is important to follow these procedures: 

1. On a clean work surface, assemble no more than three modules (e.g. one TB + two TUs).  

2. Using the assembled modules as a template, carefully mark the center of all module-mounting 
holes on the panel.  

3. Return the assembled modules to the clean work surface, including any previously mounted 
modules.  

4. Drill and tap the mounting holes for the recommended M4 or #8 screw.  

5. Place the modules back on the panel and check for proper hole alignment.  

6. Attach the modules to the panel using the mounting screws. 
 
TIP: If mounting more modules, mount only the last one of this group and put the others aside. This 
reduces remounting time during drilling and tapping of the next group. 

7. Repeat steps 1 to 6 for any remaining modules.  

Grounding considerations 
This product is designed to be mounted to a well-grounded mounting surface such as a metal panel. 
Additional grounding connections from the AC500 mounting tabs or DIN rail (if used), are not required 
unless the mounting surface cannot be grounded. Refer to appropriate Chapter of the S500-FBP User's 
Manual, for additional information.  

 ATTENTION 
This product is grounded through the DIN rail to chassis ground. Use zinc 
plated yellow-chromate steel DIN rail to assure proper grounding. The use of 
other DIN rail materials (e.g. aluminium, plastic, etc.) that can corrode, oxidize, 
or are poor conductors, can result in improper or intermittent grounding. 

 AC500 System dimensions 
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Figure: Dimensions of the CPU Terminal Bases (front view) 
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Figure: Dimensions of the Terminal Unit (front view) 
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Note: All dimensions are in mm (in.). Hole spacing tolerance: ±0.4 mm (0.016 in.) 
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Setting of the Slave Address of the FBP plug onto the AC500 CPU (if needed, but 
not recommended) 

Normally the FBP slave address is set using the AC500 Control Builder. Neverthless it is possible to set 
this address using the CPU. 

The FieldBusPlug must have a properly assigned slave module address. The AC500 CPU gives them an 
address at system power-up. The address can be set with the use of the display and the pushbutton on 
the top of the module. 

 Attention: The local setting of an FBP address by means of pushbuttons and display has a 
higher priority than an FBP address configured by the AC500 Control Builder! 
 
The locally set address replaces the address configured by the software. 
 
It is highly recommended to be extremely careful when modifying the address locally, because it has 
high influence on the behaviour of the application. 

Up to 99 addresses can be then set with the display. 
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Figure: Configuration on the CPU 
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To configure the FBP address, please follow the procedure described below: 

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

1. First select the item to be configured by
pressing the CFG key, the CPU changes to
configuration mode and a small triangle is
displayed on the LCD on the first right up
position of the display beside the ETH in-
scription and the already configured ad-
dress is displayed.
Press one time more the CFG key to move
the triangle to the position below ”FBP”.
The FBP is then selected, and the current
address is shown.
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press OK to accept and quit or only ESC to
exit the menu without saving the changes.
The CPU status is then displayed
run/StoP.

OK

ESC
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SYS
BATT

I/O-Bus

 

  

 ATTENTION 
If the FBP address set on the AC500 CPU module is different from those 
assigned into the Fieldbus configurator software of the Master device for that 
station, the station could not be accessed and the complete Fieldbus could not 
work properly or be completely down! 

 ATTENTION 
The modified address will only be valid after a Power OFF / Power ON! 

A AC500 CPU equipped with a FieldBusPlug is always a slave device on the bus. To act as a master, a 
AC500 CPU should be equipped with master couplers (e.g CM572-DP for PROFIBUS DP). 

Make the Connection of the FieldBusPlug to the Fieldbus Master Device 

The FieldBusPlug module has to be connected to the master device and the power supply has to be 
provided. Please use the dedicated accessories to the FBP used for the desired Fieldbus. 

Refer to the FBP documentation for the installation instructions. 
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Status display and error indication on the AC500 CPU 

All AC500 CPUs have LEDs and a LC Display for indicating operating statuses and errors. The following 
drawing shows the front face of a AC500 CPU. 
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The CPU statuses are displayed on the CPU front
face with 3 LEDs:

– PWR
– RUN
– ERR
– and by means of a background-lighted display

The display contains the following indications:

– small black squares indications acting as a
LED status for the device written beneath

– small black arrows used for indication by
pointing the selected device to be con-
figured or read

– 6 x 7-segment displays for “plain text” or
error codes display

 

Figure: Front face of a AC500 CPU 

The display’s background lighting is normally switched off. The status of the CPU is shown as plain text 
"run" or "Stop", which reflects the operating status of the CPU program. 

By pressing one of the dialog keys "RUN, DIAG, CFG or VAL", the background lighting is turned ON 
and the desired function is performed. 

In case of a function error, the display background lighting is also switched on and an error code is 
displayed. 
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The meanings of the LEDs and the LCD display are listed in the following table: 

AC500 CPU module LEDs 

LED Status Color LED = ON LED = OFF LED flashes 

PWR 24 V DC 
power supply 
is provided 

green voltage is present voltage is 
missing 

-- 

RUN activity status green CPU is in RUN 
mode 

CPU is in 
STOP mode 

If flashes fast (4 Hz): 
The CPU is 
reading/writing the SD 
card, indicates together 
with the blinking error 
LED that the CPU is 
writing the internal Flash 
EEPROM. 
If flashes slow (1 Hz): 
The firmware update 
from the SD card is 
finished without errors.  

ERR error indication red An error has 
occurred. The 
error type and 
code is displayed 
in the LC Display. 
The error codes 
can be shown by 
means of the 
DIAG and OK 
keys. 

No errors are 
encountered or 
only warnings 
(E4 errors). 
This is 
configurable 
(by error 2 - 4, 
the LED 
behaviour is 
configurable. 

Flashing fast (4 Hz): 
Indicates together with 
RUN a firmware update 
process and a Flash 
EEPROM write. 

 Working 
activity of the 
beneath 
described 
device (e.g. 
top right of the 
display ETH 
communication 
line). 

black Device is present 
and OK (e.g. the 
battery is present 
and OK). 

No activity or 
device not 
present 

Flashing according to 
the device activity, e.g. 
when data exchange on 
ETH, COM1, etc... 
communication lines. 

 or  Indicates the 
selected 
device to be 
read or 
configured. 
Acts as a 
cursor moving 
with the arrow 

  keys 

black Points out the 
selected device 
of which the 
name is written 
beneath (e.g. top 
right of the 
display ETH 
communication 
line). 

No device 
selected 

-- 
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Displaying error messages (error codes) on the AC500 CPU 

When an error occurs, the red error LED goes on and an error message is displayed in the LC Display. 

By pressing the DIAG key, the complete error code can be shown and an acknowledgement of the error 
can be performed. 

ETH
FBP
COM1
COM2

PWR RUN ERR

RUN DIAG

VAL CFG

ESC

OK

PM581

INSERT
PUSH

MC
502

SYS
BATT

I/O-Bus

CPU
24 V DC  10 W

WARNING!
Use of

incorrect
battery may
cause fire or
explosion.

By using the DIAG and
the OK or the ESC push-
buttons, the error mes-
sage/code can be dis-
played and the error can
be acknowledged.

DIAG OK ESC

 

Figure: Error display on the CPU 

The AC500 CPU can display various errors according to the error classes. The following error classes 
are possible. The reaction of the CPU is different for each type of error. 

Error class Type Meaning Example 

E1 Fatal error A safe function of the operating system 
is no longer guaranteed. 

Checksum error in the 
system Flash or RAM error 

E2 Severe error The operating system is functioning 
without problems, but the error-free 
processing of the user program is no 
longer guaranteed. 

Checksum error in the 
user Flash, independent of 
the task duration 

E3 Light error It depends on the application, if the user 
program should be stopped by the 
operating system or not. The user 
should decide, which reaction is 
necessary. 

Flash could not be 
programmed, I/O module 
has failed. 

E4 Warning Error in the periphery (e.g. I/O) which 
only can have influence in the future. 
The user should decide the reaction to 
provide. 

Short-circuit at an I/O 
module, the battery is 
exhausted or not inserted. 

 

 Note: The error messages are displayed as error codes using the Control Builder software (via 
PLC browser). Errors are displayed as text in the status line of the Control Builder software or with 
function blocks for diagnosis. 
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How an error message is built-up in the display 

An error always consists of an Error Class (E1 to E4, see the previous table) and a number (0 to 63) 
which indicates the identifier of the error for direct error recognition. Moreover, there are further four 
detailed error codes from d1 to d4 which define the error in detail: 

E1...E4 = 00...63 (error identifier) e.g. wrong value, checksum error, short-circuit, exhausted or 
missing battery, etc. which is directly displayed in the LCD 

-> d1 = 000...015 indicates the component which has sent the error (coupler, CPU, 
COM1, FBP, IO-Bus, etc.) 

  d2 = 000...255 defines the faulty device within the component 
  d3 = 000...030 defines the part of the module with an error (slot) 
  d4 = 000...031 defines the channel within the module 

Example of an error display for an exhausted battery 

To display the complete error codes, please follow the procedure described below: 

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

The CPU is running. The display only shows
the RUN status and the background lighting is
OFF.

OK

ESC

or

When an error occurs, the red ERR LED goes
on. An error message is output after pressing
the DIAG  key and, for example, the screen
shown to the right displays ”E4=008”. Accor-
ding to the error level, E1 to E4 can be dis-
played.

In this example, ”E4=008 ” is a warning (E4)
and ”008” means ”Empty/Missing” .

By pressing on the DIAG button, the LCD
background lighting is turned ON, the error
codes can be displayed to achieve more (dea-
per) diagnostic. The display shows ”d1=009”
(detail level 1) and ”009” indicates that the
CPU has sent the error.

DIAG

By pressing DIAG one more time, the display
shows ”d2=022” (detail level 2) and ”022” indi-
cates that the device type = battery.

DIAG

By pressing DIAG one more time, the display
shows ”d3=031” (detail level 3) and ”031”
means ”no module type” (= device itself).

DIAG

By pressing DIAG one more time, the display
shows ”d4=031” (detail level 4) and ”031”
means ”no channel” (= device itself).

DIAG

By pressing OK, the error is acknowledged
and the display returns to the normal state.
ESC returns to the normal state without ack-
nowledging the error!

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

ETH
FBP
COM1
COM2

SYS
BATT

I/O-Bus

 

Figure: Example of an error display for an exhausted battery 

Please refer to the Error Code list for further information. See the AC500 user manual. 
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LEDs on S500-FBP modules 

All S500 modules have LEDs for the display of operating statuses and error messages. They indicate: 

LED Meaning Color LED = ON LED = OFF LED flashes 

digital input yellow input = ON input = OFF -- Input 

analog input yellow brightness depends on the value of the 
analog signal 

-- 

digital output yellow output = ON output = OFF -- Output 

analog output yellow brightness depends on the value of the 
analog signal 

-- 

UP process 
voltage 24 V 
DC via 
terminal 

green voltage is present voltage is missing -- 

PWR 24 V DC via 
FBP 

green voltage is present voltage is missing -- 

S-ERR Sum Error red serious error, data 
exchange is 
stopped, depends 
on the behaviour of 
the master 

no error error (e.g. error 
on one 
channel, data 
exchange is not 
stopped 

FBP FBP 
communication 

green communication 
between FBP and 
FBP Interface 
Module is running 

communication 
between FBP and 
FBP Interface 
Module is broken 

during 
initialization 

I/O-Bus I/O-Bus 
communication 

green communication 
between FBP 
Interface Module 
and the I/O 
modules is running 

no communication 
between FBP 
Interface Module 
and the I/O 
modules 

error on one I/O 
expansion 
module (e.g. 
one output 
short-circuited) 

CH-ERR1 red 

CH-ERR2 red 

CH-ERR3 red 

CH-ERR4 

Channel Error, 
error 
messages in 
groups (digital 
or analog 
inputs and 
outputs 
combined into 
the groups 1, 
2, 3, 4) 

red 

serious error within 
the corresponding 
group 

no error error on one 
channel of the 
corresponding 
group (e.g. one 
output short-
circuited) 

CH-ERR 
*) 

Module Error red error within the I/O 
module 

-- -- 

*) All of the LEDs CH-ERR1 to CH-ERR4 (as far as they exist) light up together 

For the meaning of the different LEDs and their behaviour when the system is running, please refer to 
the S500 System Data of the S500 User’s manual for further information. 
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FBP LEDs – PROFIBUS DP 
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 AC500 Modules Specifications 

Please refer to the AC500 User’s Manual chapter System Data. 

AC500 Modules Certifications 

Please refer to the AC500 User’s Manual chapter System Data. 
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Getting Started with S500-FBP 

Important user information 

Solid state equipment has operational characteristics differing from those of electromechanical 
equipment. Because of this difference, and also because of the wide variety of uses for solid state 
equipment, all persons responsible for applying this equipment must satisfy themselves that each 
intended application of this equipment is acceptable. 

In no event will ABB be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the 
many variants and requirements associated with any particular installation, ABB cannot assume 
responsibility or liability for actual use based on the examples and diagrams. 

No patent liability is assumed by ABB with respect to use of information, circuits, equipment, or software 
described in this manual. 

Throughout this manual we use notes to make you aware of safety considerations. 

 WARNING 
Identifies information about practices or circumstances that can cause an 
explosion in a hazardous environment, which may lead to personal injury or 
death, property damage, or economic loss. 

 IMPORTANT 
Identifies information that is critical for successful application and 
understanding of the product. 

 ATTENTION 
Identifies information about practices or circumstances that can lead to 
personal injury or death, property damage, or economic loss. Attentions help 
you: 

• identify a hazard 
• avoid a hazard 
• recognize the consequence 

SHOCK HAZARD Labels may be located on or inside the device to alert people that dangerous 
voltage may be present. 

SHOCK HAZARD Labels may be located on or inside the device to alert people that surfaces may 
have dangerous temperatures. 

Environment and Enclosure Information 

 ATTENTION 
Environment and Enclosure 
 
This equipment is intended for use in a Pollution Degree 2 industrial 
environment, in overvoltage Category II applications (as defined in IEC 
publication 60664-1), at altitudes up to 2000 meters without derating. 
 
This equipment is considered Group 1, Class A industrial equipment according 
to IEC/CISPR Publication 11. Without appropriate precautions, there may be 
potential difficulties ensuring electromagnetic compatibility in other 
environments due to conducted as well as radiated disturbance. 
 
This equipment is supplied as "open type" equipment. It must be mounted 
within an enclosure that is suitably designed for those specific environmental 
conditions that will be present and appropriately designed to prevent personal 
injury resulting from accessibility to live parts. The interior of the enclosure must 
be accessible only by the use of a tool. Subsequent sections of this publication 
may contain additional information regarding specific enclosure type ratings 
that are required to comply with certain product safety certifications. 
 
See NEMA Standards publication 250 and IEC publication 60529, as 
applicable, for explanations of the degrees of protection provided by different 
types of enclosure. Also, see the appropriate sections in this publication, as 
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well as the S500 User's manual for additional installation requirements 
pertaining to this equipment. 

Before starting 

Use this document as a guide for installing and powering-up your S500-FBP Interface Module. You 
should already be familiar with the system components. 

How to handle S500-FBP components 

 ATTENTION 
Preventing Electrostatic Discharge 
 
This equipment is sensitive to electrostatic discharge, which can cause internal 
damage and affect normal operation. Follow these guidelines when you handle 
this equipment: 

• Touch a grounded object to discharge potential static. 
• Wear an approved grounding wrist strap. 
• Do not touch connectors or pins on component boards. 
• Do not touch circuit components inside the equipment. 
• If available, use a static-safe workstation. 
• When not in use, store the equipment in appropriate static-safe 

packaging.  

Make sure that you have all the components you need 

To use the S500-FBP Interface Module you should use at least the following parts: 

Part Number Designation 

1SAP220000R0001 DC505-FBP, Interface Module with 8DI/8DC 24 V DC 

1SAP210000R0001 or 
1SAP212000R0001 

TU505, FBP Terminal Unit with screw or TU506, FBP Terminal Unit with 
spring 

See the FBP Catalog FieldBusPlug module with desired Fieldbus protocol 

You may also use these components with the S500-FBP Interface: 

If you want to: Then use this component: 

• connect a 24 V dc digital sensor or 
actuator to the device 

DI524 (32 DI ), DC522 (16DC), DC523 (24DC), 
DC532 (16DI/16DC) or  DX522 (8DI/8 DO-R) with 
the corresponding terminal unit with screw-type or 
spring connection TU515/516 or TU531/532 

• connect a 115-230 V AC digital sensor or 
actuator to the device 

DX531 (8DI 115-230 V AC / 4 DO-R) + 
corresponding Terminal Unit TU531/532 with 
screw or spring technology 

• connect a 24 V DC analog sensor or 
actuator to the device 

AI523 (16AI U/I/PT100), AO523 (16AO), 
AX521(4AI/4AO U/I/PT100) or AX522 (8AI/8AO 
U/I/PT100) + corresponding Terminal Unit 
TU515/516 

• Label the I/O Channels TA523 (Pluggable marking holder) + TA525 
Markers for marking holder. 
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System planning 

Consider the following when planning your S500-FBP system: 

• The S500-FBP controller is always the left-most module in the system.  
• The FieldBusPlug delivers the power supply for the FBP interface module DC505 and the connected 

I/O bus; the additional I/O modules have to be installed to the right of the FBP Interface Module.  
• The DC505-FBP Interface module supports as many as 7 I/O expansion modules.  
• An additional process power supply has to be provided for the I/Os of each module. Each I/O 

expansion module can be powered with its own power supply (isolation purpose) or the same power 
supply can also be used.  

• One FieldBusPlug can be used in a S500-FBP cluster.  

Installation steps 

√   Installation step: Further 
information 

 1 Snap the FBP Terminal Unit onto DIN Rail or screw it (wall mounting)  

 2 Snap the additional Terminal Units for I/O modules onto DIN Rail 
(optional) or screw them (wall mounting) 

 

 3 Make the sensor/actuator wire connections according to the dedicated 
Electronic module you want to use (see dedicated pages), connect 
also a Process Power supply to the modules. 

 

 4 Plug the different Electronic modules in the right place (FBP Interface 
module on TU, and eventually also I/O modules onto dedicated TUs) 

 

 5 Make the FBP fieldbus connection acc. to the chosen FBP and use the 
dedicated FBP accessories (cables, master cable to M12, line 
termination, power supply connector, etc...) 

(*) 

 6 Plug the FBP-Plug on the M12 connector located on the Terminal Unit 
of the S500-FBP Interface Module 

 

 7 Set the correct address onto the FBP Interface Module (rotary 
switches) 

 

 8 Install the appropriate EDS/GSD files into the Fieldbus configurator (for 
use with AC31 or AC500 Control Builder) or use a dedicated Fieldbus 
Configurator tool using GSD/EDS configuration files of your Master 
device 

 

 9 Set the power on (process power supply first and FBP power supply)  

 10 Start the communication  

(*) Refer to the Installation Instructions of the used FBP device. 
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Assembling the System 

 WARNING 
The S500-FBP modules are not designed for removal or insertion under power. 
Because of unforeseeable consequences, it is not allowed to plug or unplug 
modules with the power being ON. 
  
If you connect or disconnect the FBP plug while power is applied to this module 
or the wiring while the process power supply is on, an electrical arc can occur. 
This could cause an explosion in hazardous location installations. 
  
Be sure that power is removed or area is non-hazardous before proceeding. 

 

Using S500 I/O Modules 

The S500 I/O modules could be used either directly connected to an AC500 CPU (central expansion) or 
together with an FBP Interface Module DC505-FBP + an FBP (PROFIBUS DP, DeviceNet, etc.) as 
decentralized expansion. 

DC532DC532PM581CM577CM572

 

Figure: S500 I/O modules directly connected to an AC500 CPU (central I/O expansion) 
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DC532DC532DC505

 

Figure: S500 I/O modules connected to an FBP Interface Module DC505-FBP with an FBP 
(decentralized expansion) 
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Minimum spacing 

DC532DC532DC505

DC532DC532DC505

DIN rail,
earthed

Mounting
plate,
earthed

DIN rail,
earted

Mounting
plate,
earthed

Cable duct

20 mm minimum distance between
the modules and the cable duct

 

Figure: AC500/S500 module mounting into cabinets 

Maintain spacing from enclosure walls, wireways, adjacent equipment, etc. Allow minimum 20 mm (1 in.) 
of space on all sides, as shown. This provides ventilation and electrical isolation. 
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 Important: Horizontal mounting is highly recommended. Vertical mounting is possible, 
however, derating consideration should be made to avoid problems with poor air circulation and the 
potential for excessive temperatures (see also the AC500 system data, operating and ambient 
conditions, for reduction of ambient temperature). 

 

 Note: By vertical mounting, always place an end-stop terminal block (e.g. type BADL, P/N: 
1SNA399903R0200) at the bottom and on the top of the modules to properly secure the modules. 

By high vibration applications and horizontal mounting, we also recommend to place end-stop 
terminals at the right and left side of the device to properly secure the modules, e.g. type BADL, 
P/N: 1SNA399903R0200. 

Mounting the System 

 ATTENTION 
During panel or DIN rail mounting of all devices, be sure that all debris (metal 
chips, wire strands, etc.) is kept from falling into the controller. Debris that falls 
into the controller could cause damage while the controller is energized. 

Mounting and Demounting of the Terminal Unit and Electronic Module 

Mounting on DIN rail 

Step 1: Install the 7.5 mm or 15 mm DIN Rail  

Step 2: Snap the FBP-Terminal Unit (TU505 or TU506)  

 

Figure: Mounting of the FBP Terminal Unit (TU505 or TU506) 

The FBP Terminal Unit will be placed on top of the DIN Rail and then snapped on the bottom. Follow the 
reverse order to disassembly. 
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Figure: Disassembly of the FBP Terminal Unit (TU505 or TU506) 

Step 3: Mounting of the I/O Terminal Unit (TU515, TU516, TU531 or TU532) 

 

Figure: I/O Terminal Unit assembly (TU515, TU516, TU531 or TU532) 

The I/O Terminal Unit is installed on the DIN rail in the same way as the FBP Terminal Unit. Once 
secured on the DIN rail, slide the I/O unit to the left until it fully locks into place creating a solid 
mechanical and electrical connection. 

Up to 7 I/O Terminal Units could be combined with a FBP Terminal Unit. 

 ATTENTION 
When attaching the FBP, FBP Interface and I/O modules, make sure the bus 
connectors are securely locked together to ensure proper electrical connection. 
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1 2 7...

 

Figure: Maximum configuration (1 FBP Terminal Unit plus 7 I/O Terminal Units) 

Disassembly of a Terminal Unit 

 

Figure: I/O Terminal Unit disassembly (TU515, TU516, TU531 or TU532) 

A screwdriver is inserted in the indicated place to separate the Terminal Units. 
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Step 4: Module assembly 

DC505

 

Figure: Mounting of the module 

The module will be plugged on the Terminal Unit. And will be locked in place. 

The disassembly is done in reverse order. 

1

2

1

 

Figure: Module disassembly 

For disassembly, press top and bottom, then pull out the module. 
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Panel mounting  

If the Terminal Unit should be mounted with screws, a Wall Mounting Accessory TA526 must be inserted 
at the rear side first. This plastic part prevents bending of the Terminal Unit while screwing on. 

1

2
Front view

Rear view

Rear view

Holes for
wall mounting

31
 

Figure: Fastening with screws of the Terminal Unit TU516 (as an example) 

1  The Wall Mounting Accessory TA526 is snapped on the rear side of the Terminal Unit like a DIN rail. 
The arrow points to the right side. 

2  Accessory for wall mounting inserted 

3  Terminal Unit, fastened with screws. Use two screws per module. Use M4 or #8 pan head screws. 
Mounting screws are required on every module.  

By wall mounting, the Terminal Unit is earthed through the screws. It is necessary that 

• the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated) 
• the  mounting plate is earthed 
• the screws have a good electrical contact to the mounting plate 

The following procedure allows you to use the assembled modules as a template for drilling holes in the 
panel. Due to module mounting hole tolerance, it is important to follow these procedures: 

1. On a clean work surface, assemble no more than three modules.  

2. Using the assembled modules as a template, carefully mark the center of all module-mounting 
holes on the panel.  

3. Return the assembled modules to the clean work surface, including any previously mounted 
modules.  

4. Drill and tap the mounting holes for the recommended M4 or #8 screw.  

5. Place the modules back on the panel and check for proper hole alignment.  

6. Attach the modules to the panel using the mounting screws. 
 
TIP: If mounting more modules, mount only the last one of this group and put the others aside. 
This reduces remounting time during drilling and tapping of the next group. 

7. Repeat steps 1 to 6 for any remaining modules. 
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Grounding considerations 

This product is designed to be mounted to a well-grounded mounting surface such as a metal panel. 
Additional grounding connections from the S500 mounting tabs or DIN rail (if used), are not required 
unless the mounting surface cannot be grounded. Refer to appropriate Chapter of the S500-FBP User's 
Manual, for additional information. 

 ATTENTION 
This product is grounded through the DIN rail to chassis ground. Use zinc 
plated yellow-chromate stell DIN rail to assure proper grounding. The use of 
other DIN rail materials (e.g. aluminium, plastic, etc.) that can corrode, oxidize, 
or are poor conductors, can result in improper or intermittent grounding. 

S500 system dimensions 

67.5 (2.66)

TU505/506

59
 (

2.
32

)

70
.5

 (
2.

78
)

TU515/516/531/532

13
5 

(5
.3

1)

67.5 (2.66)

(2.27)

DC505

135 mm
(5.31) inches

57.7

Dimensions:

 

Figure: Dimensions of the Terminal Unit (front view)
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28

21 (0.83)
54 (2.13)

75 (2.95)

59
 (

2.
32

)

70
.5

 (
2.

78
)

13
5 

(5
.3

1)

76
 (

2.
99

)

View on the left side View on the right side

77 (3.03)

84.5 (3.33)

DIN rail 15 mm
DIN rail 7.5 mm

135 mm
(5.31) inches

Dimensions:

(1.10)

 

Figure: Dimensions of the Terminal Unit with module (lateral view) 

Note: All dimensions are in mm (in.). Hole spacing tolerance: ±0.4 mm (0.016 in.) 

 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-72  AC500 / Issued: 07.2006 

Setting of the slave address of the FBP plug onto the S500-FBP interface module 

The FieldBusPlug needs to get an address to be used into a fieldbus as a slave module. The S500-FBP 
Interface Module gives them an address at power-up of the system. The address should be set 
according to 2 rotary switches located on the top of the module. 

Up to 99 addresses can be then set with the switches. 

1.0

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

2.0

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

3.0

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

4.0

4.1

4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

DC532

1.0 I0

1.1 I1

1.2 I2

1.3 I3

1.4 I4

1.5 I5

1.6 I6

1.7 I7

1.8 UP

1.9 ZP

2.0 I8

2.1 I9

2.2 I10

2.3 I11

2.4 I12

2.5 I13

2.6 I14

2.7 I15

2.8 UP

2.9 ZP

3.0 C16

3.1 C17

3.2 C18

3.3 C19

3.4 C20

3.5 C21

3.6 C22

3.7 C23

3.8 UP

3.9 ZP

4.0 C24

4.1 C25

4.2 C26

4.3 C27

4.4 C28

4.5 C29

4.6 C30

4.7 C31

4.8 UP

4.9 ZP

CH-ERR3 CH-ERR4

16 DI  16 DC
Input  24 V DC

Output  24 V DC 0.5A

CH-ERR2CH-ERR1

1.0

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

2.0

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

DC505

PWR

FBP

S-ERR

I/O-Bus

1.0 I0

1.1 I1

1.2 I2

1.3 I3

1.4 I4

1.5 I5

1.6 I6

1.7 I7

1.8 UP

1.9 ZP

2.0 C8

2.1 C9

2.2 C10

2.3 C11

2.4 C12

2.5 C13

2.6 C14

2.7 C15

2.8 UP

2.9 ZP

CH-ERR2

ADDR

ADDR

x10

x1

FBP  8 DI  8 DC
Input  24 V DC

Output  24 V DC 0.5 A

CH-ERR1

Rotary switch for setting
the FBP slave address

A screwdriver with a
width of 2.5 mm to 3 mm
is required

ADDR

ADDR

x10

x1

 

Figure: Setting the FBP slave address 

The two rotary switches labelled ADDR x 1 and ADDR x 10 are used to assign an address to the 
FieldBusPlug. 

For example: to assign the address 25 to the station, turn the rotary switch ADDRx10 to the position 2 
and the ADDRx1 to the position 5, then the resulting address is 2x10 + 5x1 = 25. 

Same example but for the address 6: turn the ADDRx10 to 0 and the ADDRx1 to 6, then the resulting 
address is 0x10 + 6x1 = 6. 

 ATTENTION 
If the address set on the FBP Interface Module is different from those assigned 
into the Fieldbus configurator software of the Master device for that station, the 
station could not be accessed and the complete fieldbus could not work 
properly or be completely down! 

Make the Connection of the FieldBusPlug to the Fieldbus Master Device 

The FieldBusPlug module has to be connected to the master device and the power supply has to be 
provided. Please use the dedicated accessories to the FBP used for the desired Fieldbus. 

Refer to the FBP documentation for the installation instructions. 
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LEDs on S500-FBP modules 

All S500 modules have LEDs for the display of operating statuses and error messages. They indicate: 

LED Meaning Color LED = ON LED = OFF LED flashes 

digital input yellow input = ON input = OFF -- Input 

analog input yellow brightness depends on the value of the 
analog signal 

-- 

digital output yellow output = ON output = OFF -- Output 

analog output yellow brightness depends on the value of the 
analog signal 

-- 

UP process 
voltage 24 V 
DC via 
terminal 

green voltage is present voltage is missing -- 

PWR 24 V DC via 
FBP 

green voltage is present voltage is missing -- 

S-ERR Sum Error red serious error, data 
exchange is 
stopped, depends 
on the behaviour of 
the master 

no error error (e.g. error 
on one 
channel, data 
exchange is not 
stopped 

FBP FBP 
communication 

green communication 
between FBP and 
FBP Interface 
Module is running 

communication 
between FBP and 
FBP Interface 
Module is broken 

during 
initialization 

I/O-Bus I/O-Bus 
communication 

green communication 
between FBP 
Interface Module 
and the I/O 
modules is running 

no communication 
between FBP 
Interface Module 
and the I/O 
modules 

error on one I/O 
expansion 
module (e.g. 
one output 
short-circuited) 

CH-ERR1 red 

CH-ERR2 red 

CH-ERR3 red 

CH-ERR4 

Channel Error, 
error 
messages in 
groups (digital 
or analog 
inputs and 
outputs 
combined into 
the groups 1, 
2, 3, 4) 

red 

serious error within 
the corresponding 
group 

no error error on one 
channel of the 
corresponding 
group (e.g. one 
output short-
circuited) 

CH-ERR 
*) 

Module Error red error within the I/O 
module 

-- -- 

*) All of the LEDs CH-ERR1 to CH-ERR4 (as far as they exist) light up together 

For the meaning of the different LEDs and their behaviour when the system is running, please refer to 
the S500 System Data of the S500 User’s manual for further information. 
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FBP LEDs – PROFIBUS DP 
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S500-FBP Modules Specifications 

Please refer to the S500 User’s Manual chapter System Data. 

S500-FBP Modules Certifications 

Please refer to the S500 User’s Manual chapter System Data. 
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Examples 

Examples for introduction 

Getting started 

We will introduce you to the system using a simple example. 

DC532PM581

3

M
FE
1
2

4
5
6
7
8
9

0 V
Functional Earth

ZP
M 0 V ZP
L+ +24 V DC UP
L+ +24 V DC UP

FE

24 V DC TK501

24 V DC+
–

 

The following components are required for this example: 

• One basic unit (e.g. PM581) and one terminal base (e.g. TB511-ETH). 

• One digital I/O module DC532 (DX522 or DX531 as an alternative) and one I/O terminal unit (e.g. 
TU516). 

• One 24 VDC power supply. 

• A PC with the programming software PS501 installed. 

• One cable (TK501) to connect the PC to the basic unit. 
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Task: Assign an input signal to an output. 

In this example, we are using the programming language FBD. 

Preparations 

• Connect the PM581 controller to 24 V DC. Connect the DC532 I/O module to 24 V DC. Connect 
the COM2 interface of the controller to the COM1 interface of the PC or use an USB RS-232 
converter and connect it to the USB interface of the PC. 

• Start the PS501 software. The project last edited is opened. If necessary, close this project by 
selecting "File/Close". 

• Familiarize yourself with the main window of the software. 

 

 ATTENTION 
For a correct operation of the system, it is important to completely specify 
(configure) the device configuration in the programming software. Otherwise 
the system will bring up corresponding error messages! In case of errors, 
please refer to the chapter "System Technology / Diagnosis System in AC500" 
for required information. 
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Creating a new project 

Select "File/New". 

 

Select the desired CPU in the appearing window. In our example, select PM581. 

 

In the appearing window confirm with OK. 
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A window appears where you can select the POU name, type and language. For the name and the type 
keep the settings "PLC_PRG" and "Program". Select "FBD" for the language and confirm with "OK". 

 

You have now opened a new project. 

Note: All necessary libraries are loaded automatically. 

 

Saving the project to the PC 

First of all save the project by selecting the menu item "File/Save as". 
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Select the desired directory and enter the project name. Complete your input with "Save". 

 

In our example the project is saved under the name "First_Steps" to the folder "Projects". The file 
extension "pro" is automatically created by the software. 

Specifying the hardware configuration 

The software has to be informed about the hardware configuration, i.e. the hardware configuration has to 

be specified in the software (e.g. the I/O devices). Click on . 
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Double click the object "PLC Configuration". If the AC500 folder in the PLC configuration tree is closed, 
click on the  symbol. 

 

Click on "I/O-Bus[FIX]" and then press the right mouse button. 
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Select "Append Subelement" -> "DC532" (or the I/O module You use). 

 

Configuring the digital I/O module DC 532 

Configuring the I/O parameters 

Click on . Double click the object "PLC Configuration". By clicking on the I/O symbol, the 
module parameters are displayed and can be changed. Example for DC532: The input delay is changed 
from 8 ms (default) to 1 ms. 

 

This way you can also configure the inputs and outputs of the S500-FBP interface module DC505-FBP 
in order to use them as decentralized inputs and outputs. 
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First click on the  symbol in front of the entry "DC532" and then click on this symbol in front of the entry 
"Digital Inputs 0-15[FIX]". The I/O address mapping in the CPU is displayed: 

 

In our example, it is possible to access the digital inputs of the DC532 module as word using the address 
%IW0 (simultaneous access to the 16 inputs I0…I15) or as bytes (inputs 0 - 7 using the address %IB0, 
inputs I8 - I15 using the address %IB1) or as individual bits (addresses %IX0.0 to %IX0.7 for inputs I0 - 
I7 or %IX1.0 to %IX1.7 for the inputs I8 - I15). 

  ATTENTION 
In our example, the DC532 I/O expansion module used has digital inputs 
and also digital configurable inputs/outputs. These configurable I/Os are 
displayed in the I/O mapping either as inputs or as outputs according to 
how the channel will be used by the user! 
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The I/Os will have the following CPU addresses in the CPU mapping table: 

Channels Address in 
the mapping / 
programming 
software 

Comment 

Digital inputs 0-15 %IW0 All the 16 digital inputs combined as Word from the 
DC532 module 

Digital inputs 0-7 %IB0 All the 8 first digital inputs combined as Byte 

Digital inputs 8-15 %IB1 All the 8 following digital inputs combined as Byte 

Single digital input 0 
to 
single digital input 7 

%IX0.0 
to 
%IX0.7 

Single digital input as a bit for the input 0 to the input 7 

Single digital input 8 
to 
single digital input 15 

%IX1.0 
to 
%IX1.7 

Single digital input as a bit for the input 8 to the input 15 

Digital configurable 
inputs 16-31 

%IW1 All the 16 digital configurable I/Os as inputs in combined 
as Word from the DC532 module 

Digital configurable 
inputs 16-23 

%IB2 All the 8 following digital configurable I/Os as inputs 
combined as Byte 

Digital configurable 
inputs 24-31 

%IB3 All the 8 following digital configurable I/Os as inputs 
combined as Byte 

Single digital 
configurable input 16 
to 
single digital 
configurable input 23 

%IX2.0 
 
to 
 
%IX2.7 

Single digital configurable I/Os as input as a bit for the 
input 16 to the input 23 

Single digital 
configurable input 24 
to 
single digital 
configurable input 31 

%IX3.0 
 
to 
 
%IX3.7 

Single digital configurable I/Os as input as a bit for the 
input 24 to the input 31 

Digital configurable 
outputs 16-31 

%QW0 All the 16 digital configurable I/Os as outputs combined 
as Word from the DC532 module 

Digital configurable 
outputs 16-23 

%QB0 All the 8 following digital configurable I/Os as outputs 
combined as Byte 

Digital configurable 
outputs 24-31 

%QB1 All the 8 following digital configurable I/Os as outputs 
combined as Byte 

Single digital 
configurable output 16 
to 
single digital 
configurable output 23 

%QX0.0 
 
to 
 
%QX0.7 

Single digital configurable I/Os as output as a bit for the 
output 16 to the output 23 

Single digital 
configurable output 24 
to 
single digital 
configurable output 31 

%QX1.0 
 
to 
 
%QX1.7 

Single digital configurable I/Os as output as a bit for the 
output 24 to the output 31 

For more details concerning the I/O mapping, please refer to the AC500 User's manual. 
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Symbolic names for I/Os 

In our example we use one digital input and one digital output. We want to label them with symbolic 
names. Proceed as follows: Click on the  symbol in front of "DC532" in order to display the I/O 
configuration: 

 

Now define a symbolic name for the digital input (digital input 0) as follows. First click on the  symbol in 
front of "Digital Inputs 0-15[FIX]": 

 

In the line of input 0, click twice on "AT". Then enter the symbolic name, e.g. I0dig. 

 

Complete your input by pressing the <Enter> key (displayed entry: I0dig AT %IX0.0 …). Now the 
program can access this input by its symbolic name. Using the same procedure, we then have to label 
the digital output with a symbolic name. Click on the  symbol in front of the entry "Digital In/Outputs - 
outputs 16-31 [FIX]". 
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In the line of output 16, click twice on "AT". Then enter the symbolic name, e.g. O0dig, and complete 
your input by pressing <Enter>. 

 

Opening the Function Block Diagram editor 

From the Resources we now want to switch to the Function Block Diagram editor: Click on the  
tab and then double click on the entry PLC_PRG (PRG). The Function Block Diagram editor is opened. 

 

Position the mouse cursor into the insertion mark  of network "0001" and press the right mouse 
button. Select "Assign". 

 

The display is as follows: 

 

Now we have to enter the symbolic names previously assigned to the input and the output. Click on the 
left-hand question marks (???) and press <F2>. The Help Manager appears. Select "System Variables". 
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Select "I0dig" and confirm with "OK". Proceed in the same way for the output. At the end, click into the 
free area of network "0001". 

 

Compiling the project 

The definition of the project is now completed and the project can be built. For this purpose, select the 
menu item "Project/Rebuild all". 

 

If no errors were detected, the message "0 errors, 0 warnings" is displayed in the message box. 

Setting the communication parameters 

In order to establish the connection between the PLC and the PC, the communication parameters have 
to be set. We are using the COM2 interface of the PLC and the COM1 interface of the PC or the COM 

interface of the PC assigned by the USB RS-232 converter. Switch to the  tab. Double click 
the object "PLC Configuration". In the configuration tree, click on the  symbol in front of the 
"Interfaces[FIX]" element. 
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Click on the entry "COM2 - Online access[SLOT]" in order to display the default values of the PLC's 
COM2 interface. 

 

Then we have to define the PC interface settings. Select the menu item "Online/Communication 
Parameters". 
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In the "Communication Parameters" dialog, click on the "Gateway" button and then select the entry 
"Local" from the "Connection" list box in the appearing dialog. Then confirm your settings with "OK". 

 

Now the "Communication Parameters" dialog displays the PC interface. Press the "New" button. Enter 
any name for the new channel, e.g. COM1_PC, and select "Serial [RS232]" for the "Device" (driver). 

 

Confirm your settings with "OK".  
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Now we have to specify the corresponding parameters in the "Communication Parameters" dialog. 
Specify the serial interface of the PC with the parameter "Port": double click on the value of “Port”, 
possibly several times. Click on the "Baudrate" value and then double click the value until "19200" is 
displayed. Proceed in the same way to change the "Motorola byteorder" setting from "No" to "Yes". 
Confirm your settings with "OK". 

 

 

Testing the program with PLC hardware connected 

Proceed as follows to test the program with PLC hardware connected: 

Downloading the program to the PLC 

First we have to load the program to the controller. To do this, select the menu item "Online/Login". 

 

The software checks whether the project on the PLC is identical to the project on the PC. If the PLC 
does not yet contain a user program, the message "No program available in the controller. Should the 
new program be loaded" is displayed. If the project on the PLC differs from the project on the PC, the 
following message is displayed: 

 

Select "Yes". Then the program is downloaded from the PC to the PLC. When starting the download 
process, the PLC changes to the STOP mode. 
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Now we are going to store our program in the Flash memory of the PLC to protect it against voltage 
breakdown. To do so, select "Online/Create boot project". 

 

Starting the program 

Now we want to run the program. Select the menu item "Online/Run": 

 

In order to test the program we are going to force input I0dig to TRUE: Double click to the input "I0dig": 
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In order to set this value permanently, the Force function has to be used. With this function, the user 
defined value is set in the runtime system each time at the beginning and at the end of the program 
cycle. 

 

This way, the input is assigned to the output (i.e. set to TRUE) in each program cycle. The CoDeSys 
software displays the TRUE state in blue color (the FALSE state is displayed in black). 

 

This way, the input I0dig is assigned to output O0dig. 
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Note: The status of the I/Os can also be displayed in the PLC configuration. Click on . 
Double click on “PLC configuration”. 
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Using "Online/Logout", the connection to the PLC is disconnected and the Force function is canceled. To 
exit the CoDeSys software, select the menu item "File/Exit". 
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Examples for decentralized systems connected by network 

On principle, the configuration of decentralized systems connected by network is done in two steps: 

• The CPU has to be informed about which couplers are assigned to it (internal and/or external 
  couplers). 

• The couplers have to be informed about which peripheral devices are connected to them. 

This is done using the tool SYCON.net (opened via the tab Resources -> Tools -> SYCON.net). This tool 
is also used to create the variables lists for the individual peripheral devices. The symbolic names 
created therein are directly (online) made available for the programming software. Thus, these created 
variables are located in the Global Variables folder. 

Example with an AC500 CPU PM581 as PROFIBUS DP Master and a DC505-FBP as 
PROFIBUS DP slave with a FieldBusPlug PDP22-FBP  

DC532DC505 AX522

PDR11-FBP.150

DC505-FBP + DC532 + AX522

AC500 PM581-ETH + CM572-DP as

-FBP

AX522DC532PM581CM572

master + DC532 + AX522

PDA11-FBP.050

PDP22

+/– 24 V DC

+
– 24 V DC

+
– 24 V DC

from COM2/PLC to PC

+/– 24 V DC

 

Figure: Example with an AC500 CPU as PROFIBUS DP master and a DC505-FBP as PROFIBUS DP 
slave. Note: “to PC” – either COM1 interface of PC, directly, or corresponding COM interface of PC, 
allocated via USB RS-232 converter. 

The following example will guide you through the installation and the configuration of a small PROFIBUS 
DP fieldbus using an AC500 PLC as PROFIBUS DP master and a S500-FBP remote I/O station with a 
modular FBP.  
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This example could be used as starting point to develop your own application. 

 ATTENTION 
Refer to the dedicated User's manuals or Installation guides of the 
FieldBusPlug and the AC500 PLCs and programming software. 

Needed products 

  amount product description order number 

 1 PM581-ETH, CPU 1SAP 1401 00 R0170 

 1 CM572-DP, Communication Module PROFIBUS DP 
Master 12 Mb/s 

1SAP 170 200 R0001 

 1 TB521-ETH, CPU Terminal Base AC500, 1x CPU Slot, 
2x Coupler Slots, Ethernet RJ45 Connector 

1SAP 1121 00 R0170 

 1 TA524, Dummy Coupler Module 1SAP 1806 00 R0001 

 1 TK501, Programming Cable, D-Sub / D-Sub 1SAP 1802 00 R0001 

 1 PDA11-FBP.050, Adapter M12-Dsub9-M12, cable length 
0.50 m (field bus + power supply) 

1SAJ 9240 09 R0005 

 1 PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m, 
modular (FieldBusPlug) 

1SAJ 2401 00 R1005 

 1 PDR11-FBP.150 Terminating resistor 150 Ohm 1SAJ 9240 07 R0001 

 1 DC505-FBP with 8DI/8DC 1SAP 2200 00 R0001 

 2 DC532 with 16DI/16DC 1SAP 2401 00 R0001 

 2 AX522 with 8AI/8AO 1SAP 2500 00 R0001 

 1 TU506, FBP Terminal Unit, Spring Terminals 1SAP 2100 00 R0001 

 4 TU516, I/O Terminal Unit, 24 V DC, Spring Terminals 1SAP 2120 00 R0001 

 1 GSD file for FBP module ABB_091F.GSD 

 1 PS501-PROG, Control Builder AC500, Programming 
Software 

1SAP 1901 00 R0001 

Before starting with the following example, please: 

• Use the previous installation instructions to assemble and mount the system, also refer to the 
dedicated Users manual of the PROFIBUS DP FBP, S500-FBP and AC500 PLCs. 

• Make the wiring and provide supply power to the system (process supply) and to the FieldBusPlug 
(use dedicated accessory, e.g. PDA11-FBP.050 which allows connecting a PROFIBUS DP master 
with a 9 pins D-Sub and provides power supply for the FBP through a M12 connector). 

• Set the slave address of the FBP to 2 with the front rotary switches of the S500 FBP-Interface 
module (chosen for this example; see also S500-FBP Getting started). 

• Install the AC500 Control Builder programming software for AC500 PLCs 
• Install the SYCON.net fieldbus configurator 
• Install GSD and EDS files 
• Connect the programming cable TK501 from the PC to the AC500 PLC 
• Review all of the hardware instructions for your specific system to be sure you have completed all of 

the required preliminary steps prior to beginning the system configuration with the AC500 Control 
Builder programming software. 

• Power up the system 
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Starting the programming software 

Start the AC500 Control Builder programming software. Select "File/New" to create a new project.  

 

Select the desired CPU in the appearing window. In our example, select PM581.  

 

In the appearing window confirm with "OK". 
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A window appears where you can select the POU name, type and language. For the name and the type 
keep the settings "PLC_PRG" and "Program". Select "ST" for the language and confirm with "OK". 

 

The ST editor is opened.  

 

First, save the project under a specific name. Select the menu item "File/Save as". 

 

Select the desired directory and enter the project name (in our example: "Test3"). Complete your input 
with "Save". 
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 Specifying the hardware configuration 

The software has to be informed about the hardware configuration, i.e. the hardware configuration has to 

be specified in the software. Click on . 
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Double click the object "PLC Configuration". If the AC500 folder in the PLC configuration tree is closed, 
click on the  symbol. 

 

First the I/O devices connected directly to the I/O bus of the CPU will be entered: Click on "I/O-Bus[FIX]" 
and then press the right mouse button. 
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Select "Append Subelement" -> "DC532". 

 

Repeat this procedure to append the analog module AX522. 
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Now we are going to append the PROFIBUS DP communication module. In the configuration tree, click 
on "Couplers[FIX]" and then press the right mouse button. Select Append Subelement -> CM572 and 
then click to append the element. 

 

The coupler is appended to the tree. As the CPU also comprises an integrated Ethernet coupler we are 
going to replace ‘Couplers – Internal none’ by an Ethernet coupler. 

 

 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-104  AC500 / Issued: 07.2006 

Configuring the decentralized S500-FBP I/O station using the SYCON.net fieldbus 
configurator 

Now we are going to configure the decentralized S500-FBP I/O station. Proceed as follows: 

• In the left-hand window, click on the  symbol in front of the Tools entry. Then double click the 
entry SYCON.net. 

• The SYCON.net fieldbus configurator is opened. Using this configurator, you can configure the 
decentralized I/O station. 

 

 

In the "Fieldbus" tab, open the folder 'PROFIBUS DPV 0' by clicking on the  symbol. Do the same with 
file "Master". With the left mouse button, click on CM572-DPM. Keep the left mouse button pressed and 
drag the object into the left window to append it to the green line (this line represents the connection to 
the CPU). Release the left mouse button. 
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In the appearing window, leave the "Board No. 1" unchanged (counting mode: CPU-internal coupler = 
Board No. 0, first coupler left of the CPU = Board No. 1, second coupler = Board No. 2). 

 

Click on "Accept". The coupler is now connected to the CPU. 

 

Recommendation: You can choose the symbolic coupler name according to your plant (mark coupler 
with left mouse button; the coupler is displayed with a blue rectangle; press right mouse button -> 
symbolic name. Example for symbolic name: DPM1_AC500).
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The parameter settings of the communication coupler can be easily modified by double clicking on the 
coupler symbol (surrounded by a blue line). A window opens - click on "Configuration -> Bus 
Parameters". With that you can change the parameters. 

 

Change the desired parameters and then click OK. 

The same procedure is used to append a slave to the PROFIBUS DP master CM572-DPM. Open the 
"Slave" folder in the "Fieldbus" tab. Drag the PROFIBUS DP FieldBusPlug PDP22-FBP (DPV1 modular) 
into the left-hand window to append it to the purple line (this line represents the PROFIBUS DP fieldbus). 
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The FieldBusPlug slave is now appended to the PROFIBUS DP line. The symbolic name has been 
changed to DPS2_FBP_S500. 

 

The slave has to be correctly software configured and mapped to precisely match the true hardware 
configuration. Double click on the PDP22-FBP symbol to open a new configuration window. In this 
window the hardware configuration is described and some parameter settings can be defined. 
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The slave station has to be set up. Click on "Configuration -> Modules" in the 'Pages Tree View'. First 
select the FBP interface module DC505-FBP from the list of available modules. Click on "Append". Thus 
the selected module is added to the list of configured modules. 

 

 

 ATTENTION 
The order of the modules in the list of configured modules must match the actual 
order of hardware modules. Otherwise, the decentralized station and the 
network cannot work properly! 
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Repeat this procedure to append the modules DC532 and AX522. Then, the list of configured modules 
looks as follows: 

 

Proceed as follows to configure the module parameters. Click on "Configuration -> Parameters". Select 
the corresponding module from the list. 

 

Click on the corresponding module. 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-110  AC500 / Issued: 07.2006 

The available parameters are displayed. 

 

Example: Changing the input delay of the module DC532. 

 

Highlight the line of the desired parameter: move the cursor to that line and press the left mouse button. 

Double click with the left mouse button onto the highlighted line. Click with the left mouse button on   
to display the values available. Select the desired value by clicking with the left mouse button on that 
value. Click with the left mouse button into the area with the empty lines. Thus the change has been 
adopted. 

After you have changed all the desired parameters, click on OK to exit the parameter configuration. 

The configuration of the fieldbus modules is finished. Now the names of the communication variables 
used for data exchange between coupler and CPU program have to be specified. Proceed as follows to 
specify the variables (these variables are automatically forwarded to the AC500 Control Builder software 
in order to have them available there): 
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The upper part of the netConnect area contains a tree structure showing the master communication 
coupler CM572-DPM and the slave PDP22-FBP (DPV1 modular) with the sorted list appended. Click on 
the  symbol in front of the entry PDP22-FBP to open this branch of the tree. For each I/O module, a 
separate folder is displayed containing the corresponding data exchange variables. 

 

Click on the first folder 2 byte input. This folder represents the digital inputs of the DC505-FBP module 
(8 DI + 8 DC as input). The corresponding variables are listed in the appended list (with Name of signal, 
Data type, I/O identifier (I = input, O = output) and Name of variable (can be entered)). 

 

Enter a corresponding “Name of variable“ for each “Name of signal” .To do this, double click into the 
Name of variable field of the corresponding signal. Enter the desired variable name and press the 
<Enter> key to complete your entry. These names are used in the AC500 Control Builder software. In 
our example, we use the following system for the variable name: 
bytePROFIBUSDpslaveAddress2_S500(system)_DC505(device)_Input8_to15 (by - byte; b - bit; w - 
word). 
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Recommendation: For the planning of your plant we recommend to use symbolic names according to 
your plant. 

Assign a name to each variable. For the 8 DC (as outputs) of the DC505-FBP module: 

 

For the 16 DI + 16 DC (as inputs) of the DC532 module: 
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For the 16 DC (as outputs) of the DC532 module: 

 

For the 8 analog inputs of the AX522 module: 
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For the 8 analog outputs of the analog module AX522: 

 

After completion of the variables configuration, the fieldbus configuration is finished. 

Store the project via “File -> Safe”. 

Loading the configuration from SYCON.net to the coupler 

Now the configuration has to be loaded from SYCON.net to the coupler CM572-DP. Proceed as follows: 
In the netDevice window, click on the coupler to highlight it with a blue frame: 
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Double click on the coupler icon and select "Settings -> Driver -> 3S Gateway Driver". 

 

Select "Gateway Configuration". 

In the Communication Parameters window, you can set the parameters for the communication between 
the PC and the PLC (port: serial interface of the PC). 
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Confirm the settings with "OK". Select "Settings -> Driver -> Device Assignment" and click on "Scan". 
The configuration tool SYCON.net searches for PROFIBUS couplers connected to the stated interface.  

 

Select the device "CM572-DP" and confirm with "OK". Then press the right mouse button and select 
"Connect". 
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The coupler entry CM572-DPM is now highlighted in green, indicating that the connection is established: 

 

Press the right mouse button and select "Download". 
ATTENTION: To do this the CPU must be in ‘Stop’ state. 

 

A safety inquiry is displayed. Confirm with "Yes". 
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This downloads the configuration to the coupler. Progress of data transfer is displayed. 

 

After the download is completed, SYCON.net has to be disconnected. Press the right mouse button and 
select "Disconnect". 

 

In SYCON.net, the configuration has to be saved to a file. The system adopts the project name (in our 
example: "Test3"). Select "File/Save". 

 

Exit SYCON. Select "File/Exit". 
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Return to the AC500 Control Builder by clicking on the  button in the Windows task bar on 
the bottom of the screen. 

The AC500 Control Builder software is opened again and the fieldbus variables are automatically 
transferred to the Global Variables list of the programming software. 

Open the Global Variables in the "Resources" tab. Double click on Slot 1 <R>. The previously 
configured variables are displayed and available in the programming software. 

 

Testing the system 

In order to test the system, we are going to create a small user program according to the procedure used 
in the Getting Started example. We are using the ST programming language (structured text). The 
program should read an input of the decentralized station (DC505-FBP) and output the value to the 
DC532 device located next to the CPU. The output byte %QB0 at DC532 (located next to the CPU) is 
named with the symbolic name by_AC500_DC532_Out16_23. 

The program looks as follows: 

 

The input byte with the variable name byDps1_S500_DC505_In0_7 (signals I0 to I7 at DC505) is read 
and applied to the output byte by_AC500_DC532_Out16_23 (signals C16 to 23 at DC532). 
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New GSD file(s) 

 Note 
If you install additional GSD files to the installation of the Control Builder CD's 
GSD files they have to be added to the device catalog of SYCON.net. To do 
this apply subsequent procedure. 
The GSD files have to be copied to the corresponding directory beforehand 
(\ProgramFiles\HilscherGmbH\SYCONnet\ABBPBGenericSlaveDTM\GSD). 
 
Attention: Handling of GSD files only works that way in case of an empty 
project! 

Click on . Open the 'Tools' folder. Double click on the entry SYCON.net. 

 

Click into the window next to netDevice and select "Network/Device Catalog…" from the menu. 
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Click on . This integrates the new GSD file. Click on OK and close SYCON.net. 
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For AC1131 experts – 
connection S500-FBP I/O module to series 90 

Example with an AC31 Series 90 CPU as PROFIBUS DP Master and a DC505-FBP as 
remote I/Os 

DC532DC505 AX522

07 KT 98

BasicUnit
AdvantController31

RUN

STOP
COM2

COM1

PDA11-FBP.050

PDR11-FBP.150

DC505-FBP + DC532 + AX522

07 KT 97/98 DP

+/– 24 V DC

PDP22-FBP
+
– 24 V DC

+
24 V DC

PC

 

Figure: Example with an AC31 series 90 CPU as PROFIBUS DP master and a DC505-FBP as remote 
I/Os 

The following example will guide you through the installation and the configuration of a small PROFIBUS 
DP fieldbus using an AC31 PLC as PROFIBUS DP Master and a S500-FBP remote I/O station with a 
modular FBP.  

This example could be used as starting point to realize your own application. 

 ATTENTION 
Refer to the dedicated User's manuals or Installation guides of the 
FieldBusPlug and the AC31 PLCs and programming software. 

 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-123  AC500 / Issued: 07.2006 

Needed products 

  Quantity Product description Order number 

 1 CPU 07 KT 97/98 with PROFIBUS DP 
here: 07 KT 97 with Ethernet and PROFIBUS DP 
coupler 

 
GJR5 2530 00 R0272 

 1 Programming cable 07 SK 90 GJR5 2502 00 R0001 

 1 PDA11-FBP.050 adapter for FBP, power supply and 
field bus 

1SAJ 9240 09 R0005 

 1 PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m, 
modular (field bus plug) 

1SAJ 2401 00 R1005 

 1 PDR11-FBP.150 terminating resistor 1SAJ 9240 07 R0001 

 1 DC505-FBP with 8DI/8DC 1SAP 2200 00 R0001 

 1 DC532 with 16DI/16DC 1SAP 2401 00 R0001 

 1 AX522 with 8AI/8AO 1SAP 2500 00 R0001 

 1 TU506 FBP terminal unit for FBP interface 1SAP 2100 00 R0001 

 2 TU516 I/O terminal unit for I/O modules 1SAP 2120 00 R0001 

 1 GSD file for FBP modules ABB_091F.GSD 

 1 Programming software 907 AC 1131 GJP5 2070 00 R0102 

 

Before starting: 

• Use the previous installation instructions to assemble and mount the system, also refer to the 
dedicated User's manual of the PROFIBUS DP FBP and AC31 series 90 PLC. 

• Make the wiring and provide power supply to the system (process supply) and to the FieldBusPlug 
(use dedicated accessory, e.g. PDA11-FBP.050 which allows to connect a PROFIBUS DP master 
with a 9-pin D-Sub and provide power supply for the FBP through an M12 connector). 

• Set the slave address of the FBP to 1 with the front rotary switches of the S500-FBP module (see 
Getting Started with S500-FBP, "Setting the FBP slave address"). 

• Install the AC1131 programming software for AC31 PLCs 
• If you want to configure the fieldbus using the fieldbus configurator software 907 FB 1131, install this 

software. As an alternative, you can also use the fieldbus configurator included in the programming 
software. 

• If you want to use the fieldbus configurator 907 AC 1131 for configuration, copy the PROFIBUS GSD 
file ABB_091F.GSD to the folder \Program Files\AC1131\FB1131\Fieldbus\PROFIBUS\GSD. If you 
want to configure the fieldbus using the fieldbus configurator included in the programming software, 
copy the GSD file to the folder \Program Files\AC1131\Library\PLCConf. 

• Connect the PC (COM1) to the AC31 CPU (COM1) using the programming cable 07 SK 90. 
• Connect the CPU to the DC505-FBP module via the FieldBusPlug. 
• Switch on voltage. 
• Perform the steps given in the following instructions. 
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Variant A: Configuration using the fieldbus configurator included in the 
programming software 

First, we have to specify the hardware. Click on . Double click the object "PLC 
Configuration". Click on "Hardware Configuration". Press the right mouse button. Select "Append 
Subelement/DP Master…". 

 

Set the "Card number" in the appearing window. The following rule applies: The slot number (= card 
number) can be gathered from the identification number of the CPU. Furthermore, we can also 
determine the coupler form the identification number. The following applies: 

• GJR5 253x 00 Rxxyz with 
y = slot number  = card number = 1  
z = slot number  = card number = 2 

• Furthermore, the following code applies to y and z: 2=PROFIBUS DP / 5=DeviceNet / 6=ARCNET / 
7=Ethernet / 8=CANopen / 9=Interbus 

• For our example: CPU with identification number R0272 -> slot number 1 -> Ethernet; slot number 2 
-> PROFIBUS DP 

• Since we are using the PROFIBUS coupler in our example, the resulting card number is 2. 
 

 

Confirm with "OK". 
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Press the right mouse button and select "Append DP Slave". 

 

In the appearing window, select "PDP22-FBP (DPV1 modular) (Default)" in the File Name list box. 

 

Confirm with "OK". 

 

Click on the entry "PDP22-FBP (DPV1 modular). Press the right mouse button and select "Properties". 
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Select "Input/Output". Click on the entry DC505-FBP in the left-hand window and then click on  
"Select >>". Proceed in the same way for DC532 and AX522. 

 

Click on “OK”. The hardware is now specified. 

 

When a user program is loaded to the CPU, the configuration data of the coupler (the data are a definite 
element of a project) are loaded as well. The operating system of the PLC transfers the configuration 
data to the coupler. In addition, the configuration data can be saved together with the user program in 
the Flash memory of the controller. The configuration data stored in the Flash memory are automatically 
loaded the next time the power is switched on. 
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Variant B: Configuration using the fieldbus configurator software FB1131 

Start the fieldbus configurator software 907 FB 1131 and select "File -> New". A window appears where 
you can select a fieldbus system. 

 

Select PROFIBUS and click on OK. Now you have to configure the master. 

Select Insert -> Master from the menu bar. The mouse pointer changes to an arrow with an 'M'. Left 
click with the mouse on that position on the screen where you want to place the DP Master. Another 
window appears. 

 

In this window, select 07KT97 DPM and click on Add >> to add the selected master to the network. The 
selected master is now displayed on the right-hand side of the window. You can change the default 
address of the master and enter a comment in the 'Description' field. 

 

Click on OK and continue. 
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Now append a slave to the PROFIBUS DP line. Click below the master surrounded by a frame. A 
rectangle indicates the area where the slave will be inserted. 

Select Insert -> Slave from the menu bar. 

 

The mouse pointer changes to an arrow with an 'S'. Proceed as already described for the master in 
order to place the slave. A new window appears. 

Left click with the mouse on that position on the screen where you want to place the Slave. Another 
window appears. Scroll down in the left-hand area and select PDP22-FBP (DPV1 modular) as the 
slave. Then click on ADD >>. Your selection is displayed on the right-hand side of the window. 

 

In this window, you can also change the default station address and enter a description for the device. 
Then click on OK. 
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The configured fieldbus is displayed. 

 

Double click inside of the rectangle surrounding the slave in order to configure the slave. A new window 
named Slave Configuration appears. 

 

The modular station has to be configured in order to specify the used hardware. First, select the FBP 
interface module DC505-FBP (list of available modules ('Module' column) in the window shown above; 
the selected module is highlighted by a rectangle). Click on Append Module to insert it into the list of 
configured modules. 
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The following information is given for the selected modules: Slot number (Slot), module type (Module) 
and definition of the input bytes/words IB/IW and the output bytes/words QB/QW. Then we have to 
specify the expansion modules of the used hardware. In our example this is a digital input/output module 
DC532 and an analog input/output module AX522. 

After you have added all required modules into the configuration list, click on OK to apply the 
configuration. 

 

Call the address table before you specify the parameter data (via View -> Address Table) in order to 
update the addresses of the input/output variables. 

If you want to change the device parameters of the slave, select the device entry to highlight it by a 
rectangle. Press the right mouse button and select Parameter Data from the context menu. 
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A new window appears, showing all PROFIBUS DP parameters: 

 

For instance, click on Module if you want to change the delay time of all inputs of the module DC532. 

 

Select dc532 1sap240100r0001 and click on OK. The corresponding module parameters are displayed 
and can be changed now. 

 

Example: In order to change the delay time of the inputs, double click on Input Delay.  
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A new window appears, showing all available values. Select the desired value, e.g. 1 ms, and click on 
OK. 

 

The new value is applied. 

 

After you have changed all the desired parameters, click on OK to exit the parameter configuration. The 
following configuration is displayed:  

 

 



____________________________________________________________________________________________________________ 

G1 Introduction to AC500 1-133  AC500 / Issued: 07.2006 

In order to test the configured fieldbus, the configuration has to be downloaded to the master. Select the 
master (click on the master to highlight it by a surrounding rectangle). Select the menu item Online -> 
Download. 

 

Select 3S Gateway Driver as gateway for the download to the CPU coupler and click on OK. 
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A new window named 3S Gateway Driver Assignment is opened for setting the gateway parameters 
for the address assignment of the DP coupler in the CPU (this is only done when the gateway is used 
the first time). 

 

Click on Gateway Configuration and then select the default channel COM1_PC in the appearing 
window. 

 

Apply the selection by clicking on OK. 
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The window is closed and the software tries to establish the connection via the gateway. If the 
connection establishment is successful, the couplers are displayed in the Device Information area. 

 

Click into the field next to the coupler name to select the desired coupler (DPM) and confirm with OK.  

To perform the download, select the menu item Online -> Download. A safety inquiry is displayed. 
Answer with Yes. The configuration is then transferred to the controller. 

The address data used can be displayed using the menu item View -> Address Table. 

 

The digital inputs can be accessed via IB0 to IB5, the digital outputs via QB0 to QB2 and the analog 
outputs via QW3 to QW11. 
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Testing the system 

In order to test the system, we are going to create a small user program. We are using the programming 
language FBD. The program should read an input of the decentralized station (DC505-FBP) and output 
the value at the CPU. The program looks as follows: 

 

The first byte on the DC505-FBP is read at address %IB2.0 and output at the CPU via the address 
%QB124 (outputs A62,00 to A62,07). 





ABB STOTZ-KONTAKT GmbH
Eppelheimer Straße 82 69123 Heidelberg, Germany
Postfach 10 16 80 69006 Heidelberg, Germany
Telephone (06221) 701-0
Telefax (06221) 701-240
Internet http://www.abb.de/stotz-kontakt
E-Mail desst.helpline@de.abb.com

M
an

ua
l N

o.
: 2

C
D

C
 1

25
 0

16
 M

02
01


	Introduction (Title Page)
	Contents
	Survey - gain an overview
	System structure of AC500/S500-FBP
	AC500 system overview
	Bus systems overview
	Documentation overview
	Short description of the hardware
	Short description of the software
	Operating and displaying
	Services
	Service - Control Engineering
	Repair services and replacement devices
	Seminars/Workshops

	Addresses
	Regulations concerning the appropriate and safe setup of systems and installations

	Getting started with AC500
	Important User Information
	Before starting
	Assembling the system
	Insertion / replacement of the Lithium battery
	Insertion of the SD memory card
	Mounting the System
	AC500 System dimensions
	Setting of the FBP Slave Address
	Status display and error indication on the AC500 CPU
	LEDs on S500-FBP modules
	Specifications and Certifications

	Getting Started with S500-FBP
	Important user information
	Before starting
	Assembling the System
	Mounting the System
	S500 system dimensions
	Setting the FBP slave address
	LEDs on S500-FBP modules
	Specifications and Certifications

	Examples
	Examples for introduction
	Getting started

	Examples for decentralized systems connected by network
	Example with an AC500 CPU PM581 as PROFIBUS DP Master


	For AC1131 experts – connection S500-FBP I/O module to series 90
	Example with an AC31 Series 90 CPU as PROFIBUS DP Master



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /DEU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [595.276 841.890]
>> setpagedevice


